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DOCUMENTING THE DOCUMENTATION

The Kyma.5 documentation is presented in several forms, each appropriate for a different mode of work-
ing. This section gives you an overview of which document is best suited to which situation.

Kyma.5 Walkthrough

For tyros and veteran users alike, this is a guide to finding your way around the Kyma.5 envi-
ronment. This document gives you an overview of the environment, a strategy for approaching
this deep system one layer at a time (so you can experience Kyma as an inexhaustible source of
delight rather than a steep learning curve), and then walks you step-by-step through the new
features like your own personal tour guide. If you are new to Kyma, we recommend doing the
Kyma.5 Walkthrough first and then proceeding to the Introduction and Tutorials sections of the
Kyma 4.5 Manual. Veteran Kyma users are also advised to begin here, with the walkthrough.

Graphical Quick Reference

For instant gratification, look at this first. But then keep it around so you can refer to it anytime
you are using Kyma (that’s why we printed it on card stock, so it would stand up to a lot of
use). If you are wondering what you can do in a specific window or a subpart of a window, just
find the window in the Graphical Quick Reference and read the description associated with it.
If English is not your first language and you are looking for the minimum documentation that
you could translate, this is it! This document has the highest ratio of graphics to words, so it
would provide the most information for the least translation time. This document replaces the
Quick Reference section of the Kyma 4.5 manual.

Expressions Quick Reference

There are several new real-time operators and functions that you can use in parameter fields.
This document replaces pages 213-214 of the Kyma 4.5 manual.

What's New in Kyma.5 (Release Notes)

If you are already familiar with Kyma 4.5, this is a quick way to peruse the list of changes and
additions that have been made since the previous software release. If you are a Kyma veteran
eager to see what’s new, and you don’t have the patience to go through the walkthrough just
yet, we recommend perusing this list of changes and the Graphical Quick Reference first and
then using the Kyma.5 Walkthrough to guide you through the details of some of the powerful
new user interface options.

Kyma 4.5 Sound Design Environment (aka“the big book™)

This is a reference manual, graphical quick reference, and tutorials for Kyma version 4.5. Nearly
everything in this manual still applies to Kyma.5, so you should still keep this manual around
for reference and we recommend that you read it-especially the Introduction and the Tutorials.

Everything related to Kyma.5 is intended as an Addendum to the large manual, rather than as a
replacement for it.
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Whether you are new to Kyma or an experienced Kyma user looking for a quick introduction to the new
features in Kyma.5, these mini-tutorials will give you a rapid, hands-on immersion in all of the new fea-
tures, so you can immediately begin using them in your work.

If this is your first introduction to Kyma, we recommend that you also work through the tutorials in the
main manual in order to complete your training as a Kyma Master Power User!
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OVERVIEW

Kyma is a deep program, but it is organized in layers. You can create rich and unique sounds
straight out of the box, and, over time, begin to take control over more and more of the details
until Kyma becomes your own customized sound design environment.

This walkthrough has been organized as a step-by-step path into Kyma.5, peeling off the layers
one at a time. At each step of the way, you will be able to use Kyma in your work, and, at each
new level of understanding, you will be customizing your Sound library until Kyma evolves
into your own personalized sound design environment.

The Layers of Kyma
Here, then is the 7 step program for achieving the status of Kyma Master:

Step 1. Use the Sound Browser to familiarize yourself with the over one thousand new sounds
and effects in the Kyma Sound library. You can think of this core Sound library as the
software equivalent of “factory patches”. Once you know where these “factory
Sounds” are, how to adjust their parameters in the Virtual Control Surface, and how
they can be combined together, you can immediately begin using them in your work
and applying them to your own samples and live audio inputs.

Step 2: Immediately begin customizing the Sound library by creating and saving your own
presets for the Sounds that came with your system. Begin to expand upon the core
library by saving copies of the library Sounds with your own inputs or use the library
Sounds as inputs to your own chains of signal processing modules.

Step 3: Create more complex Sounds that evolve over time by arranging and layering Sounds
in the Timeline. Use the Controller editor at the bottom of the timeline to draw or
record time-varying parameters for your Sounds.

Step 4: Use the Sound editor to see the signal flow inside the library Sounds and Prototype
Sounds. Listen at each step along the signal path to learn how the example Sounds
were created. Use the signal flow editor to modify copies of Sounds from the Proto-
types palette or the Sound Browser. Save these as new Sounds on disk to further
expand and customize your growing Sound library.

Step 5: Further extend your Sound library by creating your own samples and analysis files
using the Tools menu, and edit them in the Samples editor or Spectrum editor.

Step 6: Learn to use arithmetic expressions to control the way parameters evolve over time and
to create dynamic relationships between parameters

Step 7: Abstract and encapsulate your Sound, hiding complexity by designing a Virtual Con-
trol Surface as a front panel or by creating a new class of Sound with its own icon and
parameters.

You can make effective use of Kyma at the very first levels, and may never find the need to go
any deeper into the program. Still, it’s reassuring to know that in Kyma the deeper levels exist
in case you ever do find a need for them, even if just occasionally.
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Reusable Sounds

Kyma is so modular and flexible that it is like an open invitation. It entices you to be a creator
rather than just a collector or consumer. As you well know, creating something that is truly new
requires some extra time and thought. In Kyma, this extra effort is not expended on a one-off
project and then lost. Once you have invested your time and brain power in creating a new
kind of synthesis or processing algorithm in Kyma, you can save your entire process and re-use
it later in a different context or applied to different source material. You have done more than
just create one sound; you have extended your working library. The more time you invest in
your Kyma system, the more powerful it becomes and the more it comes to embody your
expertise and ideas. So let’s get started!

Acknowledgements
Thanks to Jean Lewis and Matthew Goss for beta testing the Kyma.5 Walkthrough!

A Request for Feedback

If, in the course of working through the walk-through or any of the other documentation, you
come across anything that is unclear or incorrect, please let us know. We plan to continuously
revise and update the manual and post the updates at our web site, so your feedback would be
very helpful. Thanks!
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THE SOUND BROWSER

When you first start up Kyma, you see a window labeled Sound Browser on the right side of
the screen. In the Sound Browser you can locate files, audition files, test combinations of files,
and glelan useful information about any of the sound-related files stored on your computer
disk(s).

Whether you are new to Kyma or a grizzled Kyma veteran, the Sound Browser is a great place
to begin on a new sound design project. By listening to the Sounds that you and Symbolic
Sound have already created and supplied with presets, you can usually find something close to
what you need and then either tweak the parameters or combine it with other Sounds to cus-
tomize it for your own use.

As you start designing your own Sounds and presets, you can save them on disk and extend
this core library. In just a short time, you will have your own library of custom sounds and
effects that you can access quickly and reuse as part of future projects.

Navigating through the disk file hierarchy
Take a look at the contents of the Sound Browser windowv:

1. Any files that you can access from the Finder (on a Mac) or Windows Explorer (on a PC) are also accessible
from the Sound Browser; thus, if have your computers networked or if you have a network file server, you can
also use the Sound Browser to see and audition remote files.
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The level of indentation indicates the level to which one file or folder is

DEE o E@E nested within another. In this case, we can see by the indentation that
DEoooosEsszEzEs B Kyma Sound Library is a folder inside another folder named Kyma 5.
yma 5:

Disk Tracks:

Inside the Kyma Sound Library are several folders and files, one of
which is called An Overview, and inside the overview file, there are sev-
eral Kyma Sounds.

L

3

[ Documentation:

3 Examples from 4.5:

(3 Giobai Faps:

L] Kyma Sound Library:

L Overview
Cross Yocoder noise+oscil
Disk-bass loop
Disk-Motorcycle
Disk-5Singing voice
Effects-Doppler shift
Effects- EUverb
Effects-Formnt mod resyn
Effects- Harmonic resonat
Effects- Unvoiced only res
Freq/Time Scaling ¥ocoder
Frea/Time Scaling- Pete A
Freg/TimeScale- Monotoni
Freq/TimeScaling- BPHM ct

To see the contents of a file or folder, click on the little triangular arrow
next to the folder name. For example, scroll up a little in the Kyma5s
folder until you can see a folder named Examples from 4.5, and click on
| the gray triangle next to the name of the folder. The triangle turns a
|| darker shade and points downward. It also reveals its contents in an
| indented list just below the folder name. To close it, click the arrow
‘ again. It returns to its original faded color and the arrow next to it now
|

Granular sample dog&s
Granu Iar Sunth Snectr

Live freq ctrl disk rate ° - A
Live peh ctrl MotorMix bu points S|deways once again.
Morph bass to car horn
Morph dominic to carla
Morph-Hrp Yeice KBD
RAM-bass drum BPM

E@!‘!—celnphane loop

In general, faded out colors and sideways arrows indicate closed files
or folders, while saturated colors and downward pointing arrows
indicate open files or folders.

RAM-random looping ceph
RAM-whispers

Sequencer -CHANGE YC5 L&
Sequencer—Drum machine
Sequencer-KBD Arpeggiato
Sequencer - KBD rand Arpe
Sequencer — nested

Colored-coded check boxes at the top of the Browser

By now you have probably noticed that the color of the text has a
meaning as well. The color of a file name indicates its file type. For
example, black text indicates a directory name, dark blue underlined
text indicates a Sound file, and bright blue indicates the name of an
individual Sound.

Type: Sound
Name: Crossz Vocoder noise+oscil-»W0ICE
< E

Duration: ON
Comment :
Thiz wocoder has a mix of foize pius an Osciliator

To see what type of file corresponds to each color, place your mouse over each one of the col-
ored boxes that are arrayed horizontally across the top of the list. The fly-by help message tells
you which kind of file is associated with which color.

LR |RAM—whispers o
ODBEOOOCONEEEEEENE [E

By checking or unchecking the color associated with file type, you can choose to include or
remove that file type from the list, thus simplifying your visual searches. For example, position
your mouse over the bright blue color is associated with Sounds. Try unchecking it and check-
ing it and to see that it alternately hides or shows the Sounds that are in An Overview.

Information on the selected Sound or file

To get information on a file, select the file name; its information will be displayed at the bottom
of the list. For example, find and select the dark blue Sound named Cross Vocoder noisetoscil-
>VVOICE (the Sounds are arranged alphabetically). The box at the bottom of the list shows the
file type (Sound), its name, its duration, and a short comment.

Scroll down past the files in Kyma Sound Library until you see the folder named Samples (not to
be confused with the folder within the Kyma Sound Library called Sampling). Open the Samples
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folder by clicking on the triangle to the left of the folder name, open the sub-folder named ani-
mals, and select the sample named small dog grow! 1. The information displayed at the bottom of
the screenis:

Type: Sanples Fle
Di rect ory: YourD skNane: Fol der: Kyna 5: Sanpl es: Ani nal s:

Modi fied: 2 Jan 1997 3:27:24 pm
Duration: 1.82102 s

Pitch: 4 c (261.626 hz, 60.0 nn)
Sanpl es: 80307 (44.1k, 16 bhits, nono)

The “Pitch” is the pitch specified in the file header. This can be useful for individual instrument
tones, but for samples that have no particular pitch, the standard practice is to use middle C or
60 nn (nn stands for note number). The last entry tells you how many samples are in the file and
tells you how it was recorded: the sampling rate, the bit depth and whether it was a stereo or
mono recording.

Spawning a Sub-Browser

To spawn another browser containing just the files from a single folder, double click on the
folder name in the main Sound Browser. This opens a browser with the folder name as its label.
The only limitation on this is that you cannot have two browsers open on the same Sound file at
the same time, since that would create an ambiguous situation with respect to editing and sav-
ing your changes.

Auditioning a File in the Sound Browser

To hear the selected file, press the green-edged Play button at the top of the Sound Browser, or
use CtrI+Space.2

F || |RAM—whispers o
OEO0OO0NEEEERE R E

For example, try selecting and playing small dog growl!1. To stop the playback, click the Stop but-
ton at the top of the list (just to the right of the Play button), or use Ctrl+K. To replay the last
Sound played, use ctri+R. By default, the samples you play in the Sound Browser will automat-
ically loop. To play them without looping, hold down the cmd or Ctrl key when you play (or use
Cmd+Space).

You can use the Play button to play Sounds and analysis files as well as samples. For example,
scroll upwards to locate Granular classic no spectrum display, one of the Sounds in An Over-
view. Select it and play it by pressing the Play button just as you did with the small dog growl!1
sample.

2. On the Macintosh, the shortcuts can be accessed by pressing either the Command key or the Control key along with the
shortcut key.
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Using the Virtual Control Surface

When you play a Sound that has adjustable parameters, Kyma will open a Virtual Control Sur-
face, so you can change the parameter values. There’s a detailed discussion of the Virtual Con-
trol Surface in the next section (“The Virtual Control Surface” on page 14). For now, suffice it to
say that you can change the parameter values by moving the faders (sliders) with the mouse.
For example, try adjusting the volume by moving the slider just below the parameter named
Vol on the right side of the control surface.
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DSP STATUS WINDOW

When you play a Sound in Kyma, it compiles and loads a program to gener-
ate the sound on the Capybara. Depending on the algorithm, this program
could require a small fraction of a single processor, or it could require all
four of the processors on a basic Capybaras320 in order to run in real
time.

To see how much processing power is required by the Sounds you are play-
ing, open the DSP Status window (found under the DSP menu).

O pSPstatus=———— [ H
Time: 00:00:11 Time Code; 00:00:00:00
LELEEEREE R R R et
E-i-i-i_i-i-i-i E-E-i-i_i-i-i-i i-i-i-i-i-i-i-i-i-i-i-i-i-i-i-i-i-i-i-i-l-i-i-i-i-E-E-E
E"E"EE—EEEE | ETEHETEEEE | E-E-N-E-B-B-B-p-m-0-0-N-R-R-p-m-0-E-R-R-R--E-E-E-E-E-E
1 2 3 4 56 78 122 4 56 7 8 12 3456 7 8 910111213 141516 1218 102021 22 22 24 25 26 27 28

Input: Cutput 'SP Usage

Clock Source In1/2 In 374 In 5/6 In 7/8

[ [ =T 1 1T . =T P 1—ar . 1=

I mernai Igl [alIERLELY] Igl il oy IQI [alIER{ELY] IQI Hlld oy IQ
Sample Rate Digital 1/0 Format 1-4 Digital 1/0 Format 5-8

[ 44100 =1 AES /EBU =1 AES /EBU =1

The first four (or eight) meters show the input levels, and the next four
(or eight) show the output levels.

The next group of four (or if you have expansion cards, 6 to 28) meters
show how much processing power is being used on each DSP in your Capyb-
ara. Processor usage is shown in a kind of log scale, with marks at 20%,
40%, 60%, and 80% usage. The DSP associated with the right-most meter
handles audio 1/0, reading and writing disk tracks, and live MIDI mes-
sages. Synthesis and processing algorithms are scheduled on the next DSP
(going from right to left). 1T there is not enough power on a single proces-
sor, Kyma will split the algorithm up so that part of it is computed on the
next processor, and so on. Each of the processors must be running a small
program at all times and this “overhead” program is indicated by a single
green line at the bottom of the meter. IT you ever manage to come up with
a Sound that uses up all the processing power on all your processors, the
DSP Status window will flash the words “Out of Real Time” in red in the
space just above the processor usage meters.

In the example shown here, the right two meters show about 80% usage on
the first two processors, about 70% usage on the third, and about 20% of
the fourth processor. The other processors are not being used.
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K ¥y ma . 5 W A LK THROWUGH

Trying out combinations of Sounds in the browser.

One Input, Many Effects

Suppose you have an input that you’d like to try processing in various different ways. The
input could be a disk track, the live input from a microphone or CD player; it could even be the
output of another Sound.

Notice that some of the Sounds in the Sound Browser have blue-green (also known as cyan) col-
ored input arrows next to them. A cyan-colored arrow next to a Sound name in the browser list
indicates a sound-processing algorithm, and it means that you can substitute your own input for
the default input that comes with that Sound? (or algorithm) as an example.

To substitute your own input for the default input used in the Sounds marked with cyan
arrows, you first have to designate a global “replacement input”.

For example, let’s say that you wanted to try processing the Sound called RAM-whispers in
several different ways. First, select RAM-whispers in the Kyma Sound Library An Overview file,
and play it so you know what it sounds like unprocessed. Use the Virtual Control Surface fad-
ers to try out various different values for the parameters. Start controls where the loop begins
within the sample. Length controls how long the loop is. A negative value for Length causes the
loop to go backwards through the sample.

To designate it as the global replacement input, click on the cyan colored right-angle arrow just
to the left of the input field (the text field at the top of the Browser).

RN |RAM—whispers o
OROOO0ODNEEEEANEENE E

Once you click on the arrow, the name of the selected Sound will be displayed in the input field.
Notice that the connection button (the yellow arrow pointing into the cyan dot just to the right
of the name of the input) has also been depressed. You can disconnect RAM-whispers at any
time by clicking the connection switch.

Now we are ready to try different kinds of processing on the input. Any Sound that has a light
cyan arrow next to it can be used to process the global replacement input.

Try selecting and playing Effects-Harmonic resonator (KBD). Notice that, in the info field at
the bottom of the Sound Browser, you see the word MIDI displayed in green. This indicates that
the Sound expects input from the MIDI keyboard, so try playing some chords on your MIDI
keyboard (or send the Capybara MIDI from your MIDI sequencer). Then try adjusting the val-
ues of Decay and InputScale.

Now try using the whispers as the modulator on a vocoder by playing Cross Vocoder
noisetoscil->VVOICE. As before, try experimenting with the on-screen faders.

3. In Kyma, the word “Sound” with an uppercase ‘S’ is an abstract data structure representing anything from an
elemental source of audio signal (like an oscillator or the microphone input), to a compound chain of signal
processing modules and mixers (which can itself in turn be used as a source of audio signal). So a filter with a
sample as its input is called a Sound just as a disk track is also called a Sound. (If you don’t like this terminol-
ogy, you can substitute the word “module” or “algorithm” for the word “Sound”).
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To hear the selected Sound with its original default input, disconnect the replacement input (by
clicking the “connection” button to the right of the input field). Try this out now with Cross
\Vocoder noisetoscil->VOICE: disconnect the RAM-Whispers input, play Cross Vocoder
noiset+oscil->VVOICE. Connect RAM-Whispers by clicking on the “connection” button again.
After changing the state of the connection button, you have to hit the play button again before
you will hear the result.

Now try Effects-Formnt mod resynth as the processing algorithm on the whisper sample.

Change the Input field to Disk-bass loop* (by selecting Disk-bass loop and clicking the right-
angle cyan arrow button next to the input field). Play Effects-Harmonic resonator (KBD)
with an A flat minor 7th chord on the MIDI keyboard, Cross Vocoder noisetoscil->VVOICE and
Effects-Formnt mod resynth again, this time using Disk-bass loop as the replacement input.

To use the live input from a microphone (or any other line-level input connected to channel 1 of
the Capybara) as the replacement input, click the cyan colored Microphone button just to the
left of the right-angle arrow button.

w | |_ | Audio Input 1 |qr|

L1 B8 100 5 O] 0 6 G0 =]

Kyma will now function as an effects processor, processing whatever you say or sing into the
microphone. Try the same set of processing algorithms Effects-Harmonic resonator (KBD),
Cross Vocoder noisetoscil->VOICE, and Effects-Formnt mod resynth again but this time
using your voice as the live input.

One effect on many inputs
What about the reverse situation: you have an interesting signal processing effect, and you’d
like to try it out on several different inputs?

One convenient way to do this is to spawn a sub-browser and use it for locating input Sounds,
while using the original browser to select the processing or modifier Sounds. The designated
replacement input is global, so it will be used by both the original browser and the sub-browser
that you spawned.

For example, scroll down in the Sound browser until you see the folder named Samples 3rd
Party. Double-click on the Samples 3rd Party folder to spawn a new browser. In the Samples 3rd
Party browser, open the sub-folder Sounds Good and the sub-folder named Sample Material and
select the sample bucket2.

Designate bucket2 as the replacement input in the sub-browser, and play Effects-Harmonic
resonator (KBD) in the original Sound browser.

Continue browsing through the Samples 3rd Party folder and try out some other samples as
inputs. If you have some of your own samples, use the Sound Browser to spawn a sub-browser
on the folder where they are stored. Try placing one of your samples into the input field and
then process it using the cyan-arrowed Sounds in the original Sound Browser.

4. This sample is courtesy of Thomas Tibert, producer of the Sounds Good sample library. This particular loop
came from his CD called On the Jazz Tip. Check out all of his titles at http://www.ivo.se/sounds.good/.
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Saving a new combination

While trying out different combinations of inputs and effects, you may come across one or two
that you consider good enough to save for future use. That is the whole idea behind Kyma,
after all: creating your own ways of processing and synthesizing sound. In order to start saving
Sounds, you will need to know how to create new Sound files and save them to the disk.

Kyma Sounds are stored on disk in collections called Sound files (rather than each Sound being
stored in its own file). To create a new Sound file, choose New... from the File menu (or use
ctrl+N). Choose Sound file from the file type list in the dialog box and click the New button. This
creates an empty Sound file window. To save a Sound with the combination of input and effect
that you have created, drag the effect from the Sound Browser into the new Sound file window.
When you drag the name from the Sound Browser into the Sound file window, it turns into an
icon representing the new Sound. You can select and play these icons just as you can select and
play the Sounds by name in the browser.

For example, select bucket2 in the Samples 3rd Party sub-browser again designate it as the
replacement input. Then play Cross Vocoder noisetoscil->VOICE with bucket2 as its input.
Let’s say that you like the way this sounds and want to save it. Create a new Sound file win-
dow, and drag Cross Vocoder noise+oscil->VVOICE from the Sound Browser into the new win-
dow. Then select the icon, and use Ctrl+Space to play it.

O0="———  Untitlheli ="——————— 03
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What if you want to drag a Sound from the browser into a Sound file window with its original
input (rather than the replacement input)? To do so, disconnect the replacement input first (by
clicking on the button with the yellow arrow just to the right of the replacement input field);
then drag the Sound into the Sound file window.

To change the name of this Sound, first make sure it is still selected; then press Enter. A dialog
pOpPS Up SO you can enter a new name — Bucket Vocoder (or whatever mnemonic that will help
you find it in the future).

At this point the new Sound exists in RAM but has not been saved on the disk. To save the
Sound file on disk, choose Save... from the File menu (or use Ctrl+S). Give this collection of
Sounds a memorable name (something like Tutorial Sounds or DrumLoop Processing Sounds) and
use the file dialog to find the most suitable place to save it on disk.

o Refresh the Sound Browser’s list by clicking on the refresh button (the right-most button
with the circular arrow on it at the top of the Sound Browser).
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Any time you make a change to the files on your hard disk, either in Kyma or behind Kyma’s
back in the Finder or Windows Explorer, you have to refresh the Sound Browser so it will reflect
the changes in the directory structure.

Now you should be able to find your new Sound file in the Sound Browser as part of your
newly expanded and customized Kyma Sound Library.

Finding a Sound in the Library

The Kyma Sound Library already contains over 1800 (oops, make that 1001 now) examples, and
you have already begun adding to that number. To locate Sounds (or other files) in the library,
you can search for them by name in the Sound Browser.

Suppose, for example, that you are in need of some alien voices for a project. To search the
Kyma Sound Library for Sounds and files containing the word *alien’, first spawn a sub-
browser by double-clicking on Kyma Sound Library. That way, you can restrict your search to the
sound library rather than search your entire disk. Next, click on Kyma Sound Library, and choose
Find... from the Edit menu (or use Ctri+F). Enter a name or part of a name into the dialog box
and press Enter (or click OK). In this case, enter “alien”. When Kyma finds the first match, listen
to it. To continue searching, choose Find again from the Edit menu (or use Ctrl+G). To stop a
search at any point, click the mouse or press any key.

If you continue searching, you will find samples, analysis files and time lines as well as Sounds.
You can select and play any of these file types in the Sound Browser.

HOw TO OPTIMIZE YOUR SEARCHES IN THE SOUND BROWSER

The Find command searches the open folders, starting from the selected
file or Sound and wrapping around to the top of the list once it reaches the
end. If it does not find a match, it goes back and searches all folders
between the selection and the end, wrapping around to the top of the list
once it reaches the end.

The Sound Browser will not find a file whose file type is not selected in the
colored check boxes at the top of the browser. (For example, if the blue
box is not checked, the Find command will not bother searching for
Sounds).

To speed up your searches, check only the boxes of the file types you are
looking for.

Combinatorial explosion

By now you are starting to get the idea why we call Kyma “recombinant sound”; in Kyma you
can combine any sound with any other, quickly trying out combinations of parameter settings,
creating a combinatorial explosion of new sound possibilities. And we haven’t even scratched
the surface yet...

Next let’s look more closely at how you can use the Virtual Control Surface to create and save
innumerable sound presets and customized control interfaces.
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THE VIRTUAL CONTROL SURFACE

In the Sound Browser, play the Granular Synth Spectrum Display Sound. A Virtual Control
Surface will open, giving you on screen faders with labels.
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You have no doubt noticed by now that any time you play a Sound that happens to have adjust-
able parameters, a Virtual Control Surface like this one will automatically open on screen,
allowing you to adjust the parameters of that Sound using the mouse (or MIDI controllers). For
example, Vol, Amp, Density, etc. are the names of sound parameters. To adjust a parameter, click
on its virtual controller labeled with that parameter name, and drag it to a new position. If there
is a numeric display above the fader, you can also set a new value for the parameter by clicking
in the numeric field, typing in a new number and pressing Enter. Use the Tab key to quickly
move between the numeric fields of a Virtual Control Surface.
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Presets and Dice
At the upper left of the Virtual Control Surface (VCS), you see:

Bl o = =

= A camera icon (for taking a snapshot of the current fader settings),
= A pull-down list of presets with the currently selected preset name displayed in the win-
dow, and
= A button with a pair of dice on it (for setting the faders to random positions).
A preset is a set of values for all the controllable parameters of a given Sound, saved under a sin-

gle name. To see the Sound’s list of presets, click on the arrow to the right of the current preset
name.

To select a different preset, drag down until the desired preset name is highlighted; then let up
on the mouse.

band |Granu|ar classic synthesis E E

bpf noise

chatter

Cefault

izolated blips 58570 hz,3.2dE

sparse
= Rename preset
= Remove preset
= Remove all presets

Experiment with selecting presets for Granular Synth Spectrum Display and tweaking indi-
vidual parameters using the mouse.

CUSTOMIZING THE KYMA SOUND LIBRARY

In the upcoming section, you will start customizing your version of the
Kyma Sound Library (see how quickly you got to this point?) So now is a
good time to go into the Finder or Windows Explorer and make a duplicate
of the Kyma Sound Library before you start making changes to it.

IT you are working in your own studio, then you don't have to worry too
much about altering the original library, since you can always retrieve it
off the CD-ROM if necessary. However, if you are sharing your Kyma sys-
tem with other people, each of you will probably want to maintain your own
customized sound library as well as a shared library of everyone’s contri-
butions.

Saving a snapshot of a preset

Suppose that, as a result of your tweaking, you come across a set of parameter values that
amaze and delight you and you decide that you’d really like to save those settings for future
use.
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To save a snapshot of the current parameter settings as a preset, click the camera icon or press
Enter on your computer keyboard. Kyma will prompt you to type in a name for the preset.

CHANGING SOUNDS USING THE SOUND BROWSER

When you open a Sound file by clicking on the arrow next to its name in the
Sound Browser, you are reading that Sound file off the disk and into the
memory of your Macintosh or PC. When you make changes to those Sounds
(by adding a preset, for instance), the changes have been made to the copy
of the Sound that resides on in the memory of your computer; they have
not been made to the original Sound that is saved on your hard disk.

IT you make a change to a Sound in the browser, Kyma will mark the
changed Sound with a yellow “caution” triangle next to its name. The file
and the folders containing that changed Sound will also be marked with the
yellow caution sign to remind you that you have made a change. When you
close the Sound file or any of the folders containing that file, Kyma will
ask you if you are sure that you want to save those changes, overwriting
the copy of the Sound already stored on the hard disk. At this point you
still have a chance to bail out or to drag the changed Sound into a new
Sound file so you can save it under a new name.

A Random Walk through Timbre Space

Sometimes the quickest way to explore the “timbre space” defined by a particular Sound is to
take a random walk through it, bump into the walls, touch the ceiling, and get a feel for its
capabilities and limits. If you have ever gotten stuck looking for just the right sound, you know
that a roll of the dice can sometimes help you break out of your frustration and stir up your
imagination. Try pressing the Dice button, located just to the right of the Preset list at the top of
the Virtual Control Surface. The Dice button sets all of the parameters to random values (some-
times with amazing results!)

E Ispar’se ||3

Try rolling the dice a few times on the Granular Synth Spectrum Display to hear what kinds
of sounds you can get out of this algorithm. If you hit an interesting setting, try adjusting indi-
vidual parameters within that setting. If you find a really great setting, take a snapshot of it and
save it as a new preset.

Notice that the parameter names Vol and Amp are grayed out. The grayed out parameters
ignore rolls of the dice (which can, in this case, protect you against deafening yourself with ran-
domly large level settings). To toggle between “frozen” and “active” states, click on the param-
eter name. When a parameter is frozen, you can still change its value by hand or with a MIDI
fader, but it will not respond to the dice.
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Rearranging the Widgets

You can change the position, type, range and MIDI mapping of the widgets in the Virtual Con-
trol Surface of a Sound and save the new arrangement along with the Sound on the disk. For
example, find the Sound called Sequencer-CHANGE VCS LAYOUT in the Sound Browser,
and play it. Carefully experiment with different values for the parameters. To make small
changes in a parameter, you can hold down the shift key as you move the fader. You can also
type a value into the numeric field at the top of the fader and press Enter for it to take effect.

DutyCycle
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Durl Dur2 Dur3 NN1 NN2 NN3 Rate Start
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Let’s rearrange this VCS as follows:

= Move DutyCycle and Volume to the right side

< Remove the numeric field from the top of the Volume fader.

= Change the Dur faders into potentiometers and arrange them across the top.

= Arrange the toggle switches just below the Dur potentiometers

= Line up the three NN faders just below the three toggle boxes, and add numeric displays
to them.

= Change the step size or grid on the NN faders to be one half step.

= Make Start into a horizontal, rather than vertical fader and remove its numeric display.

Unlocking the Virtual Control Surface

To modify a VCS, you must first unlock it by clicking on the padlock icon in the upper 5
right. This puts the VCS into Edit mode rather than Play mode. When you unlock the VCS,

you see faint white squares around the widgets. Click in the center of a widget to select it

and drag to move it. Click on one of the black squares in the corners to resize the widget. To
select a group of widgets, use shift-click to extend the selection or (starting from an empty area)
draw a box around the widgets you would like to select.
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Move DutyCycle and Volume over to the right side:

Try selecting and dragging DutyCycle all the way over to the right edge of the VCS. Do the same
for Volume.

Unlocking the VCS also opens the VCS Editor, a floating window, reminiscent of a calculator in
appearance, that you can reposition wherever you like on the screen to keep it from obstructing
your view of the VCS.

The name of the selected widget is shown in the

L1 == Virtual Control Surface Editor =EI5| go|ected Value: menu (where it currently has NN1).
SEAuSnGer | Click on the arrow just to the right of where it says
NN1 to see a list of all the widgets in the VCS. You can
select a widget either by clicking on it in the VCS or
by selecting it from this list.
Chan: / Controller: lets you choose a MIDI channel
=1l and controller number to control this parameter.
toyout.. | rrange || options.. | Widget Label: is the name on the controller. By
Selacted Mated | W1 =l gefault its initial value is the same as the name of the

Chan / controtler: [none [xljves  I=lil parameter, but you can change this by typing in a

Widget Label: [Nni new name and pressing Enter.

Widget Type: | Fader [=l{] Show Nbr / Taper: lets you toggle between widgets
Show Nbr / Taper: [Motbr | Linesr [[#](] with numeric displays and those without. Taper
Min / Max / Grid: | 12 [ 72 | i refers to the units and the scale of the controller. By

default the controls are linear, but you can change
them to be logarithmic (for example, if you would
prefer to control dB than controlling linear ampli-
tude).

Min / Max / Grid: lets you set the minimum value
and maximum value for the controller. Grid is the quantization or step size of the controller.
The default range for controllers is 0 to 1 with a grid of 0 meaning continuous. In this example
NNL1 is controlling the pitch in units of note number, so its range is 12 to 72 and its grid size is set
to 1 so it increments in half steps.

Left / Top 7 Rt 7 Bot: | 263 | 206 | 484 [ 4n

Left / Top / wd 7 Ht: | 363 | 206 [ 121 | 205

Left / Top / Rt/ Bot: is the position of the widget in terms of pixels and can be used for fine
adjustments or comparisons between widgets when you are trying to line them up.

Left / Top / Wd / Ht: is similar except that it gives you the width and the height of the widget
(rather than the absolute position of its top and bottom edges). This is especially useful for mak-
ing sure that a group of widgets all share the same dimensions.

Remove the numeric field from the top of the Volume fader:

Select Volume either by clicking on it in the VCS or selecting it from the Selected Value menu in
the VCS Editor. To remove the numeric field from the top of the Volume fader, select No Nbr
from the Show Nbr: menu.

Change the Dur faders into potentiometers and arrange them across the top:
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Select all three Dur faders by drawing a selection box in the VCS. Start drawing in the empty
area below the Dur faders and extend the box part way into all three faders (it’s not necessary to
extend the box completely around the faders).

In the VCS Editor, the Selected Value is shown as --More than one-- and any changes you make
will be applied to all three. To change all three from faders to pots, click on the Widget type:
menu, and select Potentiometer.

Potentiometers are shorter than faders are, so you can shrink all three of the pots in the vertical
direction. In the VCS editor, click on the black square in the lower right hand corner of the right-
most widget.

[ swil [ swi2 <l swD3
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Carefully drag the black square upwards to shrink the height of the widget boxes to more
closely match the actual size of the pots.

Then, click in the center of Dur2 and drag all three pots up to the top of the VCS.
Arrange the toggle switches just below the Dur potentiometers:

Similarly, select all three toggle switches, and drag them upwards until they are positioned just
below the Dur pots.

Line up the three NN faders just below the three toggle boxes, and add numeric displays:

Select all three NN faders using the box selection method. Then drag all three leftward and
upwards until they are positioned just under the toggle switches.

Add numeric displays to them by selecting Number in the Show Nbr: menu of the VCS Editor.
Change the step size or grid on the NN faders to be one half step:

To see the current step size or grid, look at the Min / Max / Grid: displays in the VCS Editor. The
current step size is set to 0, meaning that the faders can choose any continuous pitch, including
the pitches in between the half steps of a piano keyboard. In many cases this is desirable, but
let’s suppose that you want to restrict the pitches to the equal tempered half steps of the piano
keys. Set the grid size to 1 by typing a 1 in the Grid field and then pressing Enter. (Later, it might
be fun to come back here and change the grid to a larger or smaller interval just to hear what
that might sound like).

Make Start into a horizontal, rather than vertical fader, and remove its numeric display:

Kyma 5.00 Page 19 July 17,2000



K ¥y ma . 5 W A LK THROWUGH

In the VCS itself, select Start and drag it to the left side of the VCS just under NN1. To change
its widget type, go to the VCS editor and select Horizontal fader from the Widget type: menu.
Then go back to the VCS to graphically resize the widget box, making it the same width as the
three NN faders just above it.

In the VCS editor, select No Nbr from the Show Nbr: menu.
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Shrink and squeeze:

Select all of the Dur, sw, NN, and Start widgets by drawing a selection box around them. Care-
fully resize all of them to be a little narrower and slightly shorter.

This will leave spaces separating them. To squeeze out the extra space, go to the VCS Editor and
select Squeeze Vertical from the Arrange... menu.

Deselect Start by shift-clicking on it. Then choose select Squeeze Horizontal from the
Arrange... menu to squish the remaining widgets together.

Reduce the size of the window:

Move Rate, Volume, and DutyCycle closer to the other widgets (but still separated to show that
they are not related to the steps of the sequencer). Resize them so that they line up nicely. Then
resize the whole VCS window by clicking and resizing in the reddish area at the lower right
corner of the VCS window.

As a final touch, let’s put a name on our new masterpiece. From the Options... menu, select
Add widget and Text. This places a text box in the VCS. To enter the text, type into the Widget
label field of the VCS Editor. Try typing, “Short Sequencer,” and then press Enter.

Resize the Text box so you can read the text, and drag it up into the upper right corner of the
VCS. Lock the VCS by clicking on the padlock icon. Kyma will ask whether you want to save all
the changes you just made to the VCS. (Yes! You do want to save your changes!) Take a moment
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now to enjoy your handiwork by playing with your new control panel and saving some presets
for it.
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Multi-level Virtual Control Surfaces

A “layout” is defined as the list of presets along with the widget types, placement and ranges.
When you combine two or more Sounds, each having its own layout, the result is a multi-level
Virtual Control Surface—a VCS with multiple layouts. You can think of these as multiple
“pages” or “levels” of a single VCS.

These multiple layouts are helpful in that they organize the controllers in logical groups. For
instance, say that you had a granular synthesis algorithm feeding into a reverberation algo-
rithm. You could keep all the controls related to the grain cloud in one layout and all the con-
trols related to the reverberation algorithm on a separate layout to make things clear.

To see this in action, select Granular classic no spectrum display in the Sound Browser and
make it the replacement input. Then select and play Effects-HarmonicResonator KBD.
Reduce the Decay and InputScale and play an interesting chord on the MIDI keyboard.

Look in the upper right hand corner of the Virtual Control Surface for the list of layouts. Click
on the arrow just to the right of the currently selected layout name so that you can see the entire
list of layouts.

: wator (KED
Effects-Harmonic resonator (KED) (before replasement)
“harmaonic resonator KED
LGranular classic no spectrum display
..GrainCloud
...GrainCloud

The currently selected layout is called Effects-Harmonic resonator (KBD) (before replace-
ment). This gives you the harmonic resonator controls only. You can use this layout when you
want to adjust the parameters of the effect without touching the parameters of the synthesis
algorithm feeding into the effect.

Try selecting the layout at the top of the list Effects-Harmonic resonator (KBD). This gives you
the merged layouts of the granular synthesis and the harmonic resonator. You can use this lay-
out when you want access to all of the parameters in all of the combined Sounds. If necessary,
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you could also rearrange it more logically using a combination of the VCS Editor and graphi-
cally resizing and repositioning.

Try selecting the layout named..Granular classic no spectrum display. These are the parame-
ters of the granular synthesis alone, without any of the harmonic resonator’s parameters.

The layouts are arranged hierarchically, with dots and indentation indicating how far away the
layout controls are from the last effect in the chain. The last effect added, the Effects-Harmonic
resonator (KBD) has no indentation, because it is at the end of the chain. Granular classic no
spectrum display is further “upstream” in the signal flow, so it has more dots before its name. If
this last bit was not immediately clear, don’t worry about it yet, because it will become com-
pletely clear by the time you get to the section on “The Sound Editor” on page 67.

VCS Editor Menus

In our earlier discussion of the VCS Editor, we went through each of the display/data entry
fields. Now let’s take a closer look at the menus.

Layout menu
The Layout menu is for renaming, removing, or combining layouts.

Return to our earlier example. of the Granular classic no spectrum display as the input to the
Effects-HarmonicResonator KBD.

We want to make this into a new compound Sound and save the changes to it, so create a new
Sound file window (Use ctri+N and choose Sound file as the type.) Drag Effects-HarmonicRes-
onator KBD from the Sound browser into the new Sound file window, select it and play it,
readjusting Decay and InputScale and playing an interesting chord on the MIDI keyboard.

Unlock the VCS to get the VCS Editor. Select the top layout in the list: Effects-Harmonic reso-
nator (KBD). Use the Layout menu to duplicate it. Use the same menu to rename it “Level con-
trols”.

Using shift-click, select all of the controls except for Amp, Density, InputScale, and Vol. Delete
these controls from this layout by choosing Remove selected widgets from the Options menu
of the VCS Editor. Rearrange the faders so they are next to each other.

Now you have an additional layout, one which includes just the level controls from each of the
two Sounds. Re-lock the VCS, and try switching to your new layout and experimenting with
the controls.

Unlock the VCS again, and select both Level controls and Granular class no spectrum display
from the list of layouts. (Use shift-click to extend the selection). From the Layout menu, select
Merge into new layout. This creates new layout with the controls from both of the original lay-
outs.

They are piled on top of each other at the moment, so click the Arrange... button, and select
Clean up this layout, arranging the faders into 9 columns. Use the Layout menu to rename the
layout ‘Merged layout’.
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Arrange
The next menu in the VCS Editor is called Arrange... and it has a list of options for graphically

rearranging groups of widgets.

Be very careful of the last option in this menu: Clean up this layout. It will
throw away all of your changes to the positions and sizes of all the widgets
in the layout. Use this option only at the beginning of your work (to specify
the number of columns you would like) or when you are ready to give up and
start over again.

The Align options are good for taking an almost straight column or row of widgets and forcing
them to be in perfect horizontal or vertical alignment along one of their edges. Distribute
means to measure the space between the first and last widget (your choice of which edge to use
in the measurement) and to evenly distribute the selected widgets within that space. Squeeze
means exactly what you think it means: squeeze out any extra space between the selected wid-
gets. Here are some examples:

Align horizontal (tops)
Decay’ Delay irect o Decay Delay irect [PFCut
allo|le % a|[®][e]%

Distribute horizontal (centers)

{_UEZ)T- %y Dscc;r ..-Q-ﬂ ﬂ F+ %y Dscc;r ..-Q-ﬂ

Squeeze horizontal

rugf 6, .Cc;:« n'olcf ]‘ E T 6, .Cc;r .Sf

Options
The right-most menu in the VCS Editor, Options..., contains all the options related to adding,

hiding, and removing widgets. You can add a box (useful for indicating logical groups of con-
trols) or some text (useful for labeling those logical groups of controls). Hiding or removing
controls can be handy when you are trying to create new sub-layouts that show only a subset of
all the available controls.

Interaction of the Virtual Control Surface and the Motor Mix

If you have a CM Automation Motor Mix™, make certain that you have it selected as your con-
troller in the Preferences and that you have connected its MIDI in and out to your Capyb-
ara=320. Once you have set it up this way, the Motor Mix and the Virtual Control Surface will
mirror each other. (If your Motor Mix powers up in Pro Tools mode by default, hold down PLAY
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and ESCAPE while turning on the power to use it with Kyma, and the same combination a sec-
ond time to switch it back to Pro Tools mode.)

In the Sound Browser, try playing the Sound called Sequencer-Drum machine synthetic to see
how this works.

D==——————Virtual Gontrol Surface ==0ou—"—————0|H
B |Seq|l.|. eeeeee Drurn mac hine |;I E
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‘2 9 3 o Q 2 Gy g D
P11 P12 P13 P14 P15 P16 P17 P18
p ) % @ Gxr o ) p
P2l P22 P23 P24 P25 P26 P27 P28
t ‘2 O 3 2 Gr ) G
P31 P32 P33 P34 P35 P36 P37 P38
<
o Cx Sy [9) 3 ) &y €.
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Switches turn stages on or off, Rotaries change pitch of synth drums.

The name of each parameter will appear on the LCD scribble strip above each vertical strip of
(from top to bottom) button / rotary / 4 buttons / fader. The name of the fader is printed on
top, and the name of the rotary is shown below.

If the on-screen control is a fader, the motorized Motor Mix fader will jump to the initial posi-
tion of the fader on screen. If the controller is a switch or a gate, it will be mapped to one the
buttons labeled with letters on the Motor Mix. When the virtual button is down or when the
toggle is checked, it corresponding button on the Motor Mix will light up. If the virtual control
is a rotary or potentiometer, it will be mapped to one of the continuous rotary controls on the
Motor Mix. The rotary knobs on the Motor Mix are continuous and control the change to a
parameter, not its absolute position (so they are not motorized). To remap your virtual faders to
the Motor Mix rotary controls (and rotaries to faders at the same time), press the Mode button
(found at the top of the left column of buttons just to the left of the Motor Mix’s left-most fader).

Virtual faders and rotaries are assigned to Motor Mix faders and rotaries from left to right. If
there are more than eight virtual controls, the next set of eight are on the “next page” of the
Motor Mix. To scroll over by a single column of faders, press the right arrow button on the
upper left of the Motor Mix. To page over by groups of eight faders, press the Bank button and
then press the right arrow. The left arrow button can be used to scroll back the other way.

Names in the virtual control surface are often longer than what can fit in the LCD scribble strip
display, so they are almost always abbreviated on the Motor Mix. To see the full name of a
parameter and its current value as a number, press the numbered button just below that param-
eter name (the horizontal row of buttons between the LCD scribble strip and the continuous
rotary).

To “zoom in” on a fader or to put it into “fine tuning mode”, press the Shift button (lower right
corner of the Motor Mix) followed by the button marked alternate. This gives you 10 times the
accuracy (by mapping the full fader throw to one tenth of the full range of values).
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To scroll through the presets, use the rotary at the top right of the Motor Mix. An abbreviated
version of the preset name is displayed in the segment display just above the rotary and the full
name appears in the scribble strip. To select a preset, press down on the rotary (which doubles

as a button).

MERGING SEVERAL MIDI STREAMS WITH THE MOTOR MIX OUTPUT

I you are using a MIDI merge to combine the output of the Motor Mix
with the output of a MIDI sequencer or other MIDI controllers, bear in
mind that the Motor Mix puts out controller data on channel 1. So all other
sources of continuous controller data should be sent to higher channels in

order to avoid conflict.

License to Explore

Now that you know how to open directories, search the Sound Library, play Sounds, use one
Sound as the input to another, and use the dice to explore timbre space, it’s time to take a break
from the written walkthrough so you can explore the Kyma Sound Library and have some fun.
When you come back to the Walkthrough, we will look at how you can start arranging and lay-
ering your Sounds in time!
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WARNINGS IN THE HELP WINDOW

Sooner or later, given the boundless combinatoriality of Kyma, you are
bound to run into something along the lines of the following message in a
Help window:

[0 =—"--——-——HelpWindbw =————VFH

arnings from Time Linc
l‘rou may have exceeded the limits of real-time computation at time 0_34373 seconds.

Our recommendation? The first and usually best strategy is to ignore it.
Play the Sound or timeline anyway and see how it sounds. Kyma is set to be
a little on the conservative side as far as when it warns you that you may
be exceeding the limits of real time computation. So usually, even after
getting this warning you can play with impunity. If, however, you hear the
sound breaking up or otherwise sounding distorted or clicky, and all the
meters in the DSP Status Window are going into the red, it could be that
you really are running out of processing power.

Some ideas for decreasing the amount of processing power required:
reduce the polyphony, reduce the number of partials or banks in an Oscilla-
torBank or Vocoder, decrease the bank size, decrease the sample rate,
record part of the Sound to disk so it is not computed in real time. (These
suggestions will make more and more sense, the more you learn about
Kyma).
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THE TIMELINE

So far in this walkthrough, we have been creating individual Sounds with lists of fixed presets.
The next step is to layer these Sounds, create sequences of Sounds, and to record or draw the
way the presets should evolve over time. To these things, you need the Timeline. To create a
new Timeline, choose New... from the File menu (or use Ctri+N), choose Timeline as the file
type, and click OK.

Overview

In the timeline, time is displayed from left-to-right, and tracks or layers are displayed from top
to bottom.
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The upper and lower edges of this window are used for controls, menus, and informational dis-
plays. Just below the information displays on the top is the time ruler that displays time in beats
or in SMPTE time code. Track information is shown on the left side of the window. Automated
parameter controls are shown in the lower half of the window. You can drag your Sounds into
the center part of the window, and their relative spatial positioning in that window will be
turned into relative start times and durations when you play the Timeline. To change the rela-
tive sizes of the top and bottom halves of the Timeline, position your cursor over the middle
line until it changes to an up and down arrow; then drag the line up or down as desired.

Throughout the Timeline, and in many other places in Kyma, you can see a help message on
how to use a particular control by positioning your mouse over it. Take a moment right now to
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position your mouse over the different displays, buttons, and menus, in order to familiarize
yourself with the capabilities of the Timeline.

How DOES THE KYMA TIMELINE DIFFER FROM A HARD DISK EDITOR OR
A SEQUENCER?

At first glance, the Kyma timeline could be mistaken for a hard disk editor
or a sequencer. That's not too surprising, since a sequencer, an editor, and
the timeline are all tools for arranging sounds in time. There are, however,
some important differences that can both explain the behavior of the
timeline and suggest things you could accomplish with the timeline that you
could not do in a sequencer or hard disk editor.

The most important difference is in what the time bars represent. In a
disk editor or audio sequencer a time bar represents a digital audio file. In
a MIDI sequencer, a time bar represents a MIDI note event. However, in
Kyma, each time bar represents a synthesis or processing algorithm—a
program running on the Capybara, starting at a particular time, perhaps
running in parallel with other programs, and stopping at a specified time.
For example, in a Kyma timeline, each bar could represent a different
effects-processing algorithm applied to the microphone with each effect
starting at a different time, some of them running in parallel and routed to
different outputs, and some of them fading out before others. So the
timeline could be viewed as a “process scheduler” or as a time-varying syn-
thesis architecture.

Once a sound is recorded to disk, it becomes fixed and unchangeable. In
Kyma, the idea is to put off the necessity of recording sound to disk until
the last possible moment (or forever if you are using Kyma in live perfor-
mance). That keeps your sounds live, performable, adjustable and easily
changeable right up until the moment when you record to disk and freeze
them in their current state.

Dragging from the Sound Browser into the Timeline

You can drag (or copy/paste) Sounds into the Timeline from anywhere Sounds are stored: the
Sound Browser, the Prototypes, a Sound file window, or a Sound editor.

For example, let’s drag a Sound from the Sound Browser and place it in the Timeline. In the
Sound Browser, inside the Overview Sound file, find the Sound called Freg/Time Scaling
Vocoder and play it once to hear what it sounds like. Take special note of the names of the con-
trols and the names of the presets in the Virtual Control Surface for this Sound, so you can see
where these controller names and presets are used in the Timeline.

Now, drag Freq/Time Scaling Vocoder from the Sound Browser into the Timeline and drop it
into the first track, close to the beginning (in other words, close to the upper left edge of the
Timeline). Don’t worry about getting it exactly in position; just place it close to the beginning,
because we can fine-tune it later.
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Next, let’s try dragging a Sound from the Prototypes strip (the palette at the top of the screen)
into the Timeline. Find the Sound named Clicks and drag it into Track 2 just below Freq/Time
Scaling Vocoder. To find a Sound in the Prototypes, you can either use Ctrl+B and type part of
the name or you can scroll down the list of categories on the left and scroll through the icons on
the right until you see the Sound’s icon.

O=———————————————— FPrototypes————— B
Sources & Generators 43 g
Sources & Benerators KED Cirl =] @ @ i P
Additive synthesis o ]
Compresslon.-";xpanslon AnalogUscil DiskP layer
Craoss synthesis g
Delays-Mono

Creating a new track

There is no limit to the number of tracks in a timeline. To create a new track beyond the four
you are given initially, just drag a Sound into the position where you need the new track, and it
will create one for you automatically.

Copying and pasting Sounds within and between windows

You’ve just finished dragging a Sound from the browser into a timeline and dragging a Sound
from the Prototypes into a Timeline. You could also have accomplished the same result Copy
from the Edit menu (or use Ctrl+C) and Paste from the Edit menu (or Ctri+V).

MOVING A SOUND FROM A TIMELINE TO ANOTHER WINDOW

To move a Sound from a timeline into another timeline or Sound file win-
dow, Copy the Sound in the timeline and then Paste it into the destination
window. You cannot drag a Sound out of a timeline, because Kyma will think
you are trying to drag it into another track of the same timeline.
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THE DIFFERENCE BETWEEN THE PROTOTYPES AND THE SOUND
BROWSER

Both the Prototypes and the Sound Browser contain Sounds that you can
use as in creating your own Sounds. In theory, the Sounds in the Proto-
types are intended to act as low-level modules that you use as building
blocks in creating more complex Sounds. The Sounds in the Sound Browser,
on the other hand, are intended to be more like “factory patches”: complex
finished examples that you can immediately apply to your own source
inputs. In practice, however, some of the Sounds in the Prototypes are
fairly complex and some of the Sounds in the browser are fairly basic. This
blurring of the distinction between building blocks and finished examples
is probably inevitable, given that any Sound in Kyma, no matter how simple
or complex, can be combined with other Sounds to create an entirely new
Sound which can, in turn, be combined with yet other Sounds, and so on in
an endless process.

There are other differences between the Browser and the Prototypes.
The Prototype strip is intended as a source of building blocks, so it con-
tains at least one example of every type of Sound module available in Kyma.
These Sounds are created at the moment you open the Prototype strip
(which happens automatically when you start Kyma). They are not stored on
disk, so they do not maintain any kind of state (such as a list of presets),
and you cannot edit them in place and save the changes. All you can do is
drag a copy of a prototype Sound from the Prototype strip into a timeline
or Sound file window and then edit the copy. By convention, any keyboard-
controlled Sounds in the Prototypes have polyphony 1 and respond to the
default MIDI channel.

The Sound Browser is more like a window on all sound-related files on your
disk. It includes, not just Sounds, but also sample files, spectral and other
kinds of analysis files, MIDI files, text files, etc. IT you drag a samples
file, an analysis file, or a MIDI file from the browser into a timeline or
Sound file window, Kyma will create a Sound that can read and interpret
that file. Sounds in the Sound Browser can be edited in place (so be care-
ful!) and their changes (including things like additions to the presets list)
can be saved on the disk. They tend to be more complex than the Sounds in
the Prototypes. For example, there are keyboard-controlled Sounds with
polyphony and effects, and there are “performance environments” that
take live input and process it interactively.

Sound Info Display and Editing

When you first drag a Sound into a timeline, the Sound is automatically selected. To deselect,
click in an empty area of the timeline. To select a Sound, click on it. To select a group of Sounds,
draw a box around them or use shift-select to add one at a time to the current selection.
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Information on the selected Sound or group of Sounds is displayed at the top of the window:
the Sound’s name, its MIDI polyphony (relevant only if it expects MIDI note events), its start
time, anchor time, duration, and end time. If you have a group of Sounds selected, these fields
shows the name and polyphony of the earliest Sound in the group, the earliest of their start
times, the latest of their end times, and the total duration of the whole group of selected
Sounds.

| FreqsTime || 1 || OD:00:00:00 || 00:00:00:00 || o0:00:30:00 |[ D0:00:30:00 ]

To remind yourself of the meaning of each field, position the mouse just above the field for
some pop up help. Extra color has been added to the borders of these fields to serve as a quick
reminder of what their contents represent. The start time field has extra color on its left edge,
the anchor time has a bluish glow, the duration has extra color around its top and both sides,
and the end time has extra color on its right edge.

These are not just information displays; they are also data entry fields. For example, to force Freqg/
Time Scaling Vocoder to start at time zero, select it, click in the start time display, change it to
read 00: 00: 00: 00, and then press Enter to save the change. (To navigate through the time
displays and the sub-fields of the time displays, use the Tab key to move forward and Shift+Tab
to move backwards).

Change the duration of Freg/Time Scaling Vocoder to 60 seconds by tabbing over until the End
time display is selected and changing it to read: 00: 00: 60: 00. Once this change takes effect,
the end of the Freq/Time Scaling Vocoder will extend off the right edge of the Timeline. Use the
zoom-to-fit button described in the next section to force the entire timeline to fit within the visi-
ble window.

Zooming

The zoom buttons that affect the display of time and duration (horizontal zooming)
are located in the lower right corner of the upper half of the timeline below the vertical
scroll bar.

The first button shrinks the length of the bars in the timeline (that is, it will zoom out to show
more time in the visible window on the timeline). The second button will make the bars longer
(that is, it will show less time in the visible window on the timeline), and the last button- the
zoom-to-fit button- forces the entire timeline to fit within the visible area without need for
scrolling.

Changing the duration of a Sound in the Timeline

In addition to specifying a new start time for the selected Sound by typing it into the info field,
you can also reposition time bars by dragging them to new positions.
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To change the duration or end time of a Sound, click on its right edge and drag the edge right-
ward or leftward to its new length.

IE;J Freq/Time Scaling Mocoder

SN o -
btd Clicks 177

h

If you reach the right edge of the timeline window, continue dragging rightward and the time-
line will scroll to the right. There is a limit to how far you can drag the right edge by hand. At
some point it is better to either: zoom out (making the graphical size of the bar smaller) or to
use the data entry displays at the top of the timeline to type in a new end time or new duration
for the selected bar.

Try this now with Clicks. Drag the bar itself as far left as it can go so it starts at time 0. Then
drag its right edge out until it has the same duration as Freq/Time Scaling Vocoder.

Time units and quantization

The left menu at the top of the timeline lets you switch between time code (absolute time in the
form of hours:minutes:seconds:frames)

[ 30 fps |[__174 frame || ouantizedGrid ||  Time edit ][ Colors |
[ clicksiza  |[ 1 || 00:00:00:02 || 00:00:00:02 || 00:01:00:00 || 00:01:00:02 | |

and bars and beats (relative time in the form of BareBeateSubdivision, controlled by the BPM
metronome).

[[Bars and Beats | | 4 bpb ||” 142048 beat || QuantizedGrid [[ Time edit ||| Colors |
| clickstze [ 1 || 1o 1 218][ 1 1e 218]| 30 0+ 0|[ 31e 1+ 218]| ]

If you ever find yourself needing to view time in terms of minutes, seconds, and fractions of a
second, see the box titled “Minutes, seconds, and fractions of seconds” on page 57 for a little
trick you can use.

Use the next menu to set the size of a grouping in terms of either frames-per-second or beats-
per-bar. For example, the screens above show a grouping of 30 frames per second and 4 beats
per bar.

The next menu is for setting quantization: the smallest duration for purposes of graphical place-
ment and time displays (but not affecting the quantization on the DSP, which is always sample-
accurate). You can specify the quantization in terms of fractions of a frame or fractions of a beat.
Several commonly used fractions are supplied in the menu, or you can type in your own arbi-
trarily small fraction.

Nudging and track-changing with the arrow keys

Once you have positioned an object close to where you want it in the timeline, you can use the
Arrow keys to nudge it just a smidgen more to the left or right. Use Shift-Arrow for larger smid-
gens.
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Arrow moves an object one quantum left or right: one fraction of a frame or one fraction of a
beat as specified in the quantization menu in terms

Shift+Arrow moves an object by the smallest unit of time: either by one frame or by one beat.

Use the up and down arrows to move the selected Sounds up or down by a track. If the target
track is already occupied, the selected Sound will jump over that track and land in the next one
down that has available space at that time.

Grid menu

The third menu from the right in the strip at the top of the timeline is the Grid menu. This puts
an invisible grid on the timeline to help you place and move objects more accurately in time.
The options are:

= Free grid which allows you to place objects at any time,

= Quantized grid which allows you to place objects on the specified quantization times only
(where the quantization has been specified in the menu just to the left of the Grid menu),

= Magnet grid makes each Sound that you drag into a track stick to the previous Sound like
a magnet. This can be useful when you are first dragging Sounds into the timeline,
because it causes the first Sound you drop into a track jump to time zero,

= Enter beat or time is the mode to use when you want to precisely specify each time or
duration by typing it in by hand.
The name of the current grid mode is always displayed on the Grid menu activation button.

Transport controls
To play the Timeline, click the green Play button in the transport controls in the upper left cor-

ner of the timeline.
I3 0 [RR 3  [ [

As a short cut, you can toggle between play and pause by pressing once on the space bar on
your computer keyboard. If you prefer to use a different key-equivalent for starting than for
stopping, use Ctrl+RightArrow to play and Space to pause. To rewind and stop, use Ctrl+Lef-
tArrow. To rewind and play, use Ctrl+Space.

Try playing the Timeline you are working on by clicking on green play button, and then pause
it by tapping once on the space bar. Try out the various key equivalents for starting, stopping,
and rewinding.

Mute and Solo
To solo a track, click on the track’s speaker icon (located on the left side of the timeline).

Trk 1 [——]ﬁ@ =] )
Trk 2 [--1 ﬁ@ i )
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To extend the solo to other tracks, use shift-click. This will silence all but the soloed tracks. Click
on it a second time to toggle it out of solo mode. A blue speaker with little blue rays of sound
coming out of the speaker icon indicates that the track is in solo mode.

To mute a track (silence it while continuing to play all the others), use Option+click (Or Ctrl+Click
on the PC). To extend the muting, use Shift+Option+click (on the PC it is Shift+Ctrl+Click). A red
line drawn through the speaker icon indicates that the track is in mute mode.

Markers

The horizontal strip just above the time ruler is reserved for markers. To insert a marker, click
on the marker insert button at the top of the Timeline, just to the right of the transport controls.

[ Mﬁ'ﬂl 4 |: | Time Code |
|  Automation || Audio | Insert a rmarker FTime |

This opens a dialog for placing the marker in one of two ways:

Press Enter to capture the time at the cursor, or
type in @ new time and click OK.

00:00: 16: 25

Capture | 1].4 I | Cancel I

= Numerically: Type in the precise time for the marker click OK. or

= By ear: Listen to the timeline and press Enter when you hear the point at which you’d like to
insert a marker. (In order to do this, you must start playing the timeline first and then click the
Marker Insert button).

Try inserting a couple of markers into your example timeline right now. First, play the timeline.
Then click the Marker Insert button. Listen to the timeline and click Capture (or press the Enter
key) at exactly the point at which you’d like to place the marker. Click the Marker Insert button
again but this time, use the tab key to tab through the fields and type in a time for the marker
and then click OK.

Next, put the timeline into pause mode, and insert a marker using the Capture button or Enter
key. The Capture button inserts a marker at the same position as the time cursor (whether you
are in pause or play mode).

Notice that the markers appear in the empty strip just above the time ruler. There you can select
them in the usual manner (by clicking or drawing a box around them). Selected markers can be
repositioned by dragging or deleted by pressing the Backspace or Delete key.

[ m |[ o0:00: 16: 25 | 3

[ Free running [ 00:00:09: 13 J|o.00.0000 | Ik I I| |no:0c|:2|n.nn

T
|oo {00 :40.00 ||:|n ;

The name of the selected marker is displayed at the far left. You can change the name of a
marker by typing a new one into the Marker name field and pressing the Enter key. Note: you

Kyma 5.00 Page 34 July 17,2000



K ¥y ma . 5 W A LK THROWUGH

cannot type spaces within a marker name in this window (because Space is interpreted by the
timeline as a play/pause toggle). To include internal spaces in a marker name, enlarge the
marker name window (using Ctrl+L), and then enter the name or phrase in the larger dialog
box.

The time of the earliest selected marker is displayed in the next field. To reposition the selected
marker to a precise time, enter the time in this field and then press Enter.

Positioning the Time Cursor

The horizontal strip just above the Sounds and the track labels (and just below the Marker area)
is dedicated to time cursor control.

| M1 |[_o0: 00: 16: 25 | 0
[_Free running [ 00:00:09: 18 [ooononoo Ik I I| |DD:DD:2ID_DD

T
|DD 00 :40.00

Using external time code to control the time cursor

At the very left, where it now says Free running, there is a menu for [ Funning

selecting the source of external control over the time cursor. Press down |tirme cade - MBI ar SHPTE
on the button to bring up the menu. MIC tirming clock

In Free running mode, Kyma and the Capybara generate their own clock for controlling the
progress of the time cursor across the screen.

In Time code mode, the Capybara reads the time code from one of the inputs on the back: VITC
in, LTC in or MIDI in so a video or a MIDI sequencer can control the time cursor.

Typing in a new position for the time cursor

The current time of the cursor is shown in the display just to the right of that menu. Like the
Sound info displays, it serves both as a display and as a data entry window. Try typing a new
time into the window followed by Enter. The time cursor will jump to that position (whether in
play or in pause mode).

Clicking in the time ruler to move the time cursor

The long strip to the right of the time display is called the “time ruler”, because of its resem-
blance to a measuring-stick. If you want the time cursor to jump back or ahead in time, click on
that time in the time ruler. The time cursor will jump to that time (in either pause or play mode).
Try this out with your example timeline right now.

Using the transport buttons to move the time cursor
While the timeline is playing, you can jump forward or backward to key points using the blue
transport buttons just to the right of the yellow pause button.

I3 | T [T R0 3 3 |

The first two buttons are for telling the time cursor to jump to the previous marker or the next
marker relative to the current position of the cursor. To jump backwards by two markers, click
twice on the Previous marker button. Play the timeline and experiment with these buttons.
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The next two buttons are for jumping to the previous or the next “important time”. In this con-
text, an “important time” is defined as the start of a time bar, the end of a time bar, or the posi-
tion of an anchor. Go ahead and try out this pair of buttons now (though, with your current
example timeline, the only important time is will find is the beginning, since both time bars are
exactly the same length and start at exactly the same time).

Applying an effect to a Sound in the timeline

To apply a modifier or an effect to a Sound in the Timeline, drag and drop the modifier onto the
Sound. The modifier can come from the Sound Browser, a Sound file window, the Prototypes,
or a Sound editor.

For example, since the dynamics of the vocoder are a little uneven in our example timeline, let’s
try putting a compressor on the vocoder. In the Compression/Expansion category in the Proto-
types window, find the Compressor. Drag it over the Freg/Time scaling Vocoder bar in the time-
line, and drop it onto the bar.

O
Sources & Generators
Sources & Generators KED Cirl = =
Additive synthesis
Comptession/Expansion RO CEEar dBI

Cross synthesis
Delays-Mono

tutorial in prog
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The name of the bar changes to Compressorl (Freq/Time Scaling (Vocoder)). Play the Timeline
to hear the results.

| Free running Il 0o:00:21: 12 |I:IIII:EII:I:DIEI.ED|

Undo and removing the last-applied effect

Undo from the Edit menu reverses the last operation you performed. For example, if you have
just dragged a modifier onto a Sound, you can remove it again by choosing Undo (or use
Ctri+2).

But what if you modified the Sound in a previous session and have already saved the timeline
on disk and done several other kinds of operations in the meantime? In that situation, Undo
would no longer serve to remove the modifier Sound. However, you can always remove the last
modifier on a Sound by selecting the Sound in the Timeline and pressing the minus key.

For example, to remove the Compressor you just placed on the vocoder, press the minus key (-
). To put it back again, choose Undo from the Edit menu.
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Replacing the input of a Sound in the timeline

To replace the input of a Sound in the timeline, Option-Drag the new input into the timeline
and drop it on the bar of the Sound whose input you would like to replace.

In our example timeline, we currently have a vocoder with a compressor on it. Let’s substitute a
Disk-bass loop (found in the Sound Browser) as the input to the compressor. Hold down the
Option key (the ctrl key on a PC), drag Disk-bass loop from the Sound Browser over the Com-
pressor(Freg/Time Scaling Vocoder) bar, and drop it onto the bar. Try playing the timeline to
hear the results. Then Undo by typing Ctrl-Z. Play the timeline again to make certain that the
vocoder is back in place.

The implied mixing architecture of the timeline

Each track of the timeline has zero or one input and has zero, one or more outputs. If you do not
specify otherwise, the outputs of all the tracks are added together in a mixer.

v
Capybaranput (05) Level_Trkl |——p| Capybaraoutput bus |
or v
Track submix output ~ |—e Trk 1 Trk 1_To_Submix |——] Submix bus |
or
No input
No output |

Track status icons
The arrangement of the track status icons roughly parallels the signal flow diagram shown in
the previous section:

Trk 1 [__]ﬁ'i} x] &)

The Track input source icon is displayed within the square brackets on the left. The double-
dash indicates that there is no input to this track (in this particular example, none is needed
because the Sound is using the cephalaphage sample as its source). Press down in this

area to get a menu of input choices for the track (including each of the analog or digital

audio inputs on the back of your Capybara).

Associated with the input are two status icons: a microphone for Audio input status, and a 5-
pin DIN to represent MIDI input status. Press down on the MIDI icon for a menu that lets you
choose a different MIDI channel on which Sounds in this track expect to receive MIDI. The
appropriate icon turns green when the Sound under the time cursor in that track expects to
receive audio or MIDI input. The icon turns red, when the input is being recorded. (Only MIDI
can be recorded in the current version of the software so you can only surmise what the next
update might have in store for you).

Starting with the grid icon just to the right of the MIDI icon, are three icons associated with the
track’s output. The Submix status icon (the square grid) represents any submixes to which you
have routed the output of this track. In this example, the track is not routed to any submixes, so
the grid is empty. You can route a track to several different submixes, and each one is repre-
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sented by a block of color in the grid and by its name in a list that you see when you press on
the grid icon.

The Mute/Solo status icon is a little speaker. Clicking on the speaker solos the track, and
option-clicking on the speaker mutes the track.

The rightmost icon is a circle with a black dot in the center (representing you) and a yellow dot
on top representing the apparent source of sound. This is the Panning status icon and later,
when we add spatialization to our example, the yellow dot will move around while the time-
line is playing, indicating the moving sound source.

Press on the panning status icon to get an Audio output menu. This gives you the option to
choose any combination of hardware outputs (corresponding to the analog or digital outputs
on the back of your Capybara) for the track. You can also opt for no output (although this
would only make sense in cases where the track output is routed to submixes instead).

E If you choose to hard-wire the track output to one or more physical outputs of the Capyb-

ara, the panning status icon is replaced with an Output channel status icon: a grid with a
green light in each output channel. Note that this is for sending the track output to specific,
fixed hardware output channels. If you want to allow for panning, use the menu to switch back
to the Use Pan Controls option. The pan controls are discussed in detail in a later section.

Effects processing applied to submixes of tracks

We’ve already seen how to modify a single Sound by simply dragging the modifier Sound and
dropping onto the time bar of the Sound to be modified. But what if you’d like to apply pro-
cessing to a group of Sounds in the timeline? For example, what if you would like to add reverb
to all the Sounds in a timeline? By sending each Sound in the group to the same submix, and
then using that submix as the input to a new track, you can apply processing to the whole
group of tracks.

Routing the output of a track to a submix

To route the output of a track to a submix, click on the Submix status icon (the square grid
icon in the track status area) until you see the submix menu. The top level of the menu
gives you a choice of connecting or disconnecting this track from any of the existing submixes.
There is also an option to create a new submix and connect to that.

Send to... F | Mew submic
Disconnect from... P

Try this now in our example timeline. Route the output of Track 1 to a new submix and name it
Vox. When you create the new submix, Kyma will supply a random letter as its default name,
or you can choose to type in a more mnemonic name instead.

For each submix this track is routed to, the Submix status icon shows a block of color. (Don’t
WOrry, you can route to more than 16 submixes, it’s just that only 16 of them will be represented
by a block of color in the status icon). The name of the submix also appears in the Submix menu
of each of the other tracks in your timeline. For example, look at the Submix menu for Track 2:

Send ta... F | Mew subrnis
Disconnect from... B Subrnix : Yox
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You could also route the output of Track 2 (or any of the other tracks) to the same submix Vox.
(For the time being, however, let’s connect Track 1 only).

Using a submix as the input to a track

To select a submix as the input to a track, click in the Track input source area to [, 4 Input
see the menu of potential inputs for this track. Input : 1

The first choice is No Audio Input (for the case where Sounds in the track are syn- :“P”:f §
thetic or use samples stored in RAM or on disk as their source of Sound). I:Eztj :

The physical inputs on the back of your Capybara make up the next group of |Input: 5
potential audio inputs to the track. Depending on your hardware configuration, [Input:e

you will see 4, 8, or for older machines 2 potential audio input channels. :“P”:: ;

nput :
The last grouping is a list of the names of all current submixes. Only the allow- |subrnis: Yo

able input sources are shown, so if a track’s output goes to a particular submix,
that submix name is absent from the list of potential inputs. You can, however, still set up such
a feedback loop by physically routing a Capybara output to Capybara input.

Try this now with our example timeline. Select Vox as the input for Track 3.

Trk 3 [Vox] ﬁ () ] &)

The name of the input is displayed within square brackets in place of the double-dashes that
were there before. Wherever it is used as an input, the color of the submix name is the same as
the color of its square in the icon where it the recipient of the input of a track. To give you a
visual indication of the submix routing, the color of the submix name in its destination track is
the same as the color of its square in the Submix status icon in the source track.

How is the audio input used in a track?

The specified audio input to a track is used only in places where there is an InputChannel
Sound in the track. (You can find InputChannel Sounds in the Prototypes under the Inputs cat-
egory). This is true whether the input is a submix of other tracks or whether it is one of the
Capybara’s input channels.

Try this out in our example timeline. Drag an InputChannel from the Prototypes into Track 3 of
the example timeline. Position it such that it does not start at time 0, and increase its duration
without making it as long as the other Sounds in the timeline.

Trk 1 -1 ﬁ @ A
Trk 2 -1 ﬁ @

Trk 3 [¥ox] @

[ 0 7~ Compressor233 (Freq/Time Scaling Yocoder) |
T ] T
O |&ciioks17s |

Q S pudioinizs |
Trk 4 I--1 ﬁ @ o O

Press play to play the timeline. When the time cursor reaches the start of InputChannel, notice
that the Audio input status icon (the microphone) turns green to indicate that audio input is
expected. In this case the source of audio for the track is a submix, so don’t be misled by the
icon into thinking that it is literally expecting the microphone input at that moment. You may
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also notice that the voice gets subtly louder for the duration of InputChannel, because the out-
put from Trackl is doubled for that period of time.

Simply doubling the output of Track 1 is clearly not what we had in mind when creating the
submix, so let’s add some processing by dropping EuverbMONO (from the Reverb-Mono cate-
gory of the Prototypes) onto InputChannel. Press Space to play the timeline. This time, you will
hear Track 1 through some reverberation for the duration of EuverbMONO(InputChannel).

Processing a submix is such a common operation that there is a shortcut for doing it. Delete
EuveroMONO(InputChannel) (select it and press Backspace or Delete). Now drag Euverb-
MONO into the (now empty) Track 3. Kyma will ask you if you’d like to replace the input of EU
with the Track input.

ﬁ Replace default input of this Sound with the track input?

| Yes || No I |I:an|:EI|

If you answer Yes, then Kyma will place a copy of EuverbMONO of an InputChannel into Track
3, starting at time 0 and lasting for the current duration of the submix. This saves you a step if
your intention is to put some processing on the submix for the duration of the submix.

If you have a pre-amplified microphone or another line-level source plugged into the first audio
input of your Capybara, try another experiment with the timeline. Switch the audio input
source of Track 3 from its current setting of Vox to Input: 1 and play the timeline again. Now if
you speak into the microphone you can accompany the alien voice and hear your own voice
through some reverberation. This is one of the ways you can use the timeline in a live perfor-
mance situation.

Switch the input to Track 3 back to Vox before proceeding.

QUICK TRICK FOR CREATING A NEW TRACK

You have to select an submix or audio input for a track before you can drag
an effect onto it and have it automatically use the audio as its input. But
what if no track exists yet? A quick trick for creating a new track is to
select a Sound in the track just above where you want to create a new one,
and use the down arrow key to move that Sound down into the empty area,
thus creating a new track there. Then you can use the up arrow to move
the Sound back to its original track before proceeding.

Routing tracks to specific output channels

To route a track to a specific output channel, first open the output menu by clicking on the circle
icon (the rightmost icon in the Tracks label). Then select an output channel (or elect to use the
Position and Panner controls instead).

Try routing Trk1 to channel 1. (Solo the track so you can more easily hear the results). Then add
channel 2 to the list of output channels. If you have a surround setup, try removing channels 1
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and 2 from the output list and adding channels 3 and 4 to the list of outputs; that should route
the output of Trkl to the surround speakers.

Notice that, when a track is routed to a set of specific output channels, the output status icon
changes to a rectangular grid with a green square for each of the output channels.

Before proceeding, switch the output of Trkl back to Use pan controls (the choice at the very
button of the pop-up menu). This will allow you to pan the output of the track around the room
to any virtual location. (More on this in the section called Spatializing).

WHAT ACTUALLY HAPPENS WHEN YOU PRESS PLAY IN THE TIMELINE?

Each bar in the timeline represents a program to be run on the Capybara.
When you press play, Kyma comes up with a way of scheduling all of those
programs to run (serially or in parallel, depending on the way you have
arranged them in the timeline) on the multiple processors inside your Capy-
bara.

You can think of each time bar as representing a virtual module in a hard-
ware architecture that changes over time. For example, if you had 20
Sounds in a timeline, but they did not overlap in time, Kyma would not
schedule all 20 of them on to run on the Capybara at the same time. Each
program runs only when it is needed. When it is finished, its computational
and memory resources can be used by another program that starts up
later. As a result of this efficient scheduling, the power of your Capybara
hardware is leveraged. Unlike a static piece of hardware which has fixed
resources at all times, the Capybara can be reused for different purposes
at different times, and this changeover is sample-accurate (in fact it
occurs in between output samples).

IT there is enough computation power on one processor to run several of
the programs, Kyma schedules several of them on a single processor. If a
program is too complex to fit on a single processor, Kyma splits it up across
several processors and makes certain that the signals get from one pro-
cessor to the other. I a program reads a sample out of memory, Kyma
makes certain that the sample is loaded on the same processor as the pro-
gram that reads it. So a lot of things have to happen each time you press
Play.

Some timeline operations that may seem trivial (such as moving a time bar
to the left or right) actually require Kyma to completely redo the schedul-
ing of the programs among the multiple processors, because moving a time
bar could result in different resources being required at different times.
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The Timeline Virtual Control Surface and Layouts

When you play a Timeline, you see a Virtual Control Surface that includes the live controls from
each Sound in the Timeline. Some of the original Sounds may already have their own arrange-
ments of controls and lists of presets, so the Timeline VCS has several pages or layers to it. Each
page is called a “layout” and includes a list of presets along with the placement, types, and
ranges of the widgets.

=————— Virtual Gontrol Surfface>=—~-———————— 0B
e =1 [l [Er——— =1 o
[ [Defautt = 5 | Time Line =8
Bandwidth Freq ¥ Rate Volume Amp Decay LPFCutoff ReverbAmp
[ os [Tos [os [os [Tos [Tos
1 1 1 1 1
< < < < < < <
-

The first page (or top layer) of controls is the layout for the Timeline itself; this allows you to
save a list of presets for the entire Timeline.

Restart the timeline using Ctrl+Space. Then use the Dice Button to generate random settings for
the variable parameters. If you stumble across something that pleases you, snapshot it as a pre-
set. Save the example timeline to disk using Save from the File menu (Ctrl+S), giving it the
name “Tutorial Timeline”. Your presets for the timeline will be saved along with the timeline
and the objects in the timeline.

You can also access the individual Sounds’ layouts from the list found at the upper right of the
VCS next to the lock icon. Click and hold down the arrow icon next to the name of the currently
selected layout so you can see the list of all the layouts in the VCS. The names of the layouts are
indented to show what layer they are on. The Timeline layout is on the top layer. On the next
layer, you can see the individual Sounds, and below the Sounds there may layouts for subparts
of the individual Sounds.

There are three Sounds in our timeline so far: Compressor(Freg/Time Scaling Vocoder) (which
we dragged from the Sound Browser) Clicks (which we dragged from the Prototypes), and the
EuverbMono, (also dragged from the Prototypes). Sounds in the Prototypes are created just
when you open the Prototype strip, so they do not have any layouts saved with them. Sounds
in the Sound Browser, on the other hand, are saved on disk and may have one or more layouts
saved with them.

For example, the Freg/Time Scaling Vocoder has several layouts for its different subparts: one
layout called Sample, one called Oscillator, and one called VVocoder. In a later section on the sig-
nal flow editor, we will go more into depth about how to view and edit the subparts of a Sound
(and in fact most of the nearly 600 page Kyma 4.5 manual is devoted to designing and editing).
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For now though, select the layout named Vocoder, and notice that there are a couple of presets
stored with the layout: Default and high data rate.

You may often find yourself designing Sounds in the Sound Browser or a Sound file window
and saving lots of presets for the Sounds. When you later use these Sounds in a timeline, you
can still get at those presets by going to the Layout list and selecting the layout for your original
Sound.

In the heat of production, you will be adding and removing live parameters
so fast that you could easily end up with a VCS full of gaps or a giant VCS
with all the controls stuck in the lower left corner. To quickly reduce the
size of a bloated VCS: click the unlock icon, and resize the VCS by dragging
on the reddish area in the lower right corner of the window. Then, in the
VCS editor, choose Clean up this layout from the Arrange menu. Caution:
Use this option only if you want to shrink the VCS to a smaller size and do
not care about the particular placement or ordering of the widgets. Clean
up this layout does an automatic placement, ordering, and resizing of the
all the widgets in the VCS.

Controlling Parameters in the Timeline

The bottom half of the timeline is dedicated to creating and editing time-varying controls for
the parameters of the timeline and the Sounds it contains.

Parameter Contrals

ShepardGlizsandal 72
FadeInOut
Panner
Distance
Direction

Interval
Yolume
Erittle-izer1 72 (zample drum H
FadeInDut 4| E |

] [[Automatea | takeO 32« a« 0| ws02 | (=] [0 [ [ (2 E EH

On the left is a list where you can select one of the controllable parameter names. On the right,
is a graph of how the parameter selected in the list varies over time. The bottom frame of the
controls editor has menus for changing the state of the controls (for example whether they are
live or automated), the source of control (for example the MIDI channel and controller number).
It also has displays showing the time and value of the selected point in the graph, and a set of
button for transforming the graphs.

INCREASING THE SIZE OF THE CONTROLLER EDITOR

To increase the size of the lower section of the Timeline, position your
cursor over the center horizontal line between the controller editor and
the timeline until the cursor changes into an up-down arrow cursor. Once
the cursor changes to the up/down arrow, you can pull the center line up or
down to change the relative sizes of the upper and lower halves of the time
line.
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Local, Track and Master Controls for Parameters
In the example timeline we’ve been working on, select Compressor (Freq/Time Scaling
Vocoder), and take a look at the list of controllable parameters.

S FaE There are three types of controls in the timeline: Parameter controls, track
e inaut controls, and master controls.
S Parameter controls correspond to the controllable parameters of the
O selected Sound(s) in the timeline. Notice that Bandwidth, Frequency, Rate,
Yolume and Volume are the same parameter names as the ones that show up in the
Track tonfre’s VCS when you play the example timeline. Three additional parameters are
Angle_Trk1 addeq to any Soqnd that you drag into the timeline: FadelnOut (_so you
Notes. Trki can give an amplitude envelope to the Sound), and Panner plus Distance
e o 0% which you can use to give the Sound a virtual location in space. Parameter
“BPM controls are “local” to the Sound, that is, they can control the parameters of

that Sound only. These controls are limited to the duration of their Sound,
and they remain with the Sound if you move the Sound to a new time or a different track.

Track controls exist for the duration of the entire timeline and they affect any of the Sounds in a
track. Track controls remain with the track, rather than with a particular Sound, so any Sound
you drag into that track will be affected by the track controls. The list shows the track controls
for the tracks containing the selected Sounds. Each track has a controller for Level, which you
can use for mixing tracks, and Angle plus Radius, which you can use for assigning the track to
a spatial location. If the track is routed to any submixes, there is also a Trk_To_Submix level
control for each of the submixes. (For example, if you wanted to send some of this track to a
reverb, you could use the submix level to send just a little of the signal to the reverb rather than
the full strength signal). Another track control, Notes, is slightly different in that it represents
discrete note events, rather than a continuous controller. For now, Notes is always live, meaning
that you can control Sounds on that track using a MIDI keyboard or sequencer, but in this ver-
sion of the software, you cannot yet record and edit MIDI note events. (Sounds like it could be a
useful feature for future releases, though).

Master controls can affect all Sounds on all tracks (but only if the Sound’s local parameter has
been slaved to the global, master controller), and they exist for the full duration of the timeline.
A default master control that is automatically supplied in any new timeline is BPM: the beats
per minute or metronome controller.

Sources of parameter control

A parameter can be controlled in one of three ways: live from the VCS or an external source of
MIDI continuous controllers, automated by a time-varying function that you’ve either drawn
or recorded into the controller editor, or slaved to another controller. The two menus at the bot-
tom of the timeline show you the state of the selected parameter and the source of its control.
You can use the State menu to change the state of the selected parameter between live, record-
ing, automated, and slaved. Use the Source menu to choose between different MIDI channels
and controller numbers (for live and recording), the different takes of recorded automation
functions, or different master controls (for slaved).
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Live controls

When you first drag a Sound into the timeline, its controllable parameters are still live, meaning
that they can be controlled from the Virtual Control Surface (VCS) or by incoming MIDI con-
troller messages from a fader box or a sequencer. A “live” parameter is indicated by a green dot
next to its name in the list of parameters. Only the live controls of the timeline show up in the
VCS (since the automated parameters can no longer be controlled by the on-screen faders).

In our example timeline, notice that all of the selected Sound’s controllable parameters have
green dots next to them in the Parameter controls list. The green dot indicates that the parame-
ter is live. Select Bandwidth in the list, and look at the two menus on the bottom of the editor.

| Live 11 CH1:ccl2 1

They show that the state of the selected parameter is live and that its source of control is either
the VCS or MIDI continuous controller 12 on channel 1. To change the MIDI channel or control-
ler number, click on the Control Source menu, and enter the new information in the dialog box.

Capturing the current settings of the VCS in the timeline

While the timeline is playing, you can adjust the live parameters using the Virtual Control.
Once you’ve arrived at some parameter settings that you like, you can capture the values of
parameters in the selected Sound by choosing Set selected live controls to current values from the
menu called Automation in the upper left of the Timeline just below the transport buttons.

B0 [ (i« [pe] [=][==l2]
Automation || Audio I |E
Set selected live controls to current valuesz
Live cantral b
dutornate all
(Record enable b
Crizable all recording

By selecting this option, you are saying that the live parameters of all currently selected Sounds
should be automated and that they should have to the same (constant) values in the timeline as
they have in the current settings of the Virtual Control Surface.

Try this out in our example timeline. Make sure Compressor (Freg/Time Scaling Vocoder) is still
selected. Then play the timeline. In the VCS, adjust the faders, and/or roll the dice. Once you
arrive at an interesting set of parameter values, go over to the Automation menu and select Set
selected live controls to current values. (The Set selected live controls to current values option applies
only to selected Sounds).
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Displaying automated parameters

To see the results, let’s revisit the list of the selected Sound’s parameter names in the lower left
of the Timeline. Note the absence of green dots. That’s because all the parameters are no longer
“live” but automated.

rParameter Controls
FadeInOut
Panner
Distance
Bandwidth
Frequency
Rate

Yolume

Track Contraols

|I| Automated I takel _I @ @

To see how a parameter’s value varies over time, click on the parameter name in this list, and its
control graph will be displayed in the area just to the right of the list. For example, if you select
Rate, you will see a graph of how the value of Rate changes over time. Right now, the value of
Rate doesn’t change over time; it is a constant value of 0.8 (or whatever value you happened to
set it to when you captured the positions of the faders in the VCS). The State menu shows that
Rate is no longer live but Automated and that its source of control is takel, the name of its con-
trol graph.

Recording VCS or MIDI fader moves

To record the controllers as you perform them in the VCS or on MIDI faders, first put the
parameter you’d like to record into record state. The next time you play the timeline, Kyma will
record all of the fader moves associated with that parameter.

To put an individual parameter into record state, select it in the parameter list and click on the
Record button just below the list. The button will turn red, and a red dot will appear next the
parameter name in the list to show that it is “armed” for recording and will begin recording the
next time you press the play button for the timeline.

Try this now with the Rate parameter. Select it, and press the record button.

Parameter Controls
Fade InOut
Panner
Distance
Bandw idth
Frequency

= Rate
Yolume

Track Controls

El Recording ” CH 1: cc24 I

Notice that the State menu indicates that you are in Recording mode and the Source menu
shows that it will be recording MIDI continuous controller 24 on channel 1 (in addition to the
on-screen fader called Rate in the VCS).
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Play the timeline, and move the Rate fader in aesthetically pleasing ways. While the time cursor
is over the Sound whose parameter(s) you are recording, the MIDI status icon for the track will
turn red.

rParameter Controls
FadeInOut
Panner
Distance
Bandwidth
Frequency
Rate
Yolume

Track Contraols

E Automated I take2 _I @ E

Record for a full minute or hit Space to pause whenever you’ve had enough. Then bring the
timeline into the front so you can see the results. (You may have to reselect Rate if it has become
deselected).

The State menu shows that Rate has been automatically knocked out of Recording mode and is
now in the Automated state. Notice that the Source menu shows the source of control as being
take2. Click on the Source menu if you’d like to return to takel instead.

Often you need to record several parameters at once, so the Automation menu provides some
shortcuts for putting groups of parameters into Record mode.

For example, select all of the Sounds in our example timeline; then go to the Automation menu
and Record enable all of the selected Sound’s parameter controls.

Automation || Audio | | Compress
Live contral » b
Autornate all
Record enable B Track contrals Cpanzs & levels)
Crizable all recording Fararneter controls

Master controls
o r 1 = ALL controls

Now play the timeline. While the timeline is playing, use the VCS to select presets, press the
Dice button, and/or adjust the faders. The timeline will record all of these parameter changes.

After you have finished recording, press Play on the timeline so you can hear your recorded
performance.

MIDI CONTROLLERS VERSUS MIDI NOTE EVENTS

Note that, although you can control Sounds in the timeline using live MIDI
keyboard events, it is not yet possible to record MIDI note events. You
can record and subsequently edit MIDI controller moves, but you cannot
record and edit MIDI keyboard events...not yet anyway.

Editing automated parameters

Now that you have created something, your first thought is probably, “How can | modify it?”
To edit an automation graph, first select the parameter you want to edit in the parameter list on
the left; this will display its automation graph in the area just to the right of the list. The time
span of the Sound whose parameter you are editing is shown with a different background color
in the Controls Editor. In other words, a parameter can’t have any effect on a Sound before that
Sound begins or after it ends. The background color of the Controls Editor highlights the span
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of time during which that parameter can have some effect, and it prevents you from adding
points outside of this time span.

To create a new version of the control function without losing the current control function, click
on the Source of Control button (where it now says takel as the source of control). Select New
Take from the menu to create a new take. This will create a new take called take2 and preserve
takel. You can give the take a more meaningful name by selecting Rename take from the
Source of Control menu.

0] To see a larger range of values or to see more detail, use the scroll bar and the Zoom in and
28] Zoom out buttons in the lower right corner of the editor.

To add a new point to an automation graph, option-click at the time and value where you
would like to place the new point. To delete a point, select it and press Backspace or Delete.

To change the position of a point already in the control function, select it and drag it to a new time
and value position. To drag several points at once, draw a box around the points or extend the
selection using shift-click; then click and drag one of the points to the new location.

To nudge a point by a small amount, use the arrow keys. The left and right arrow keys nudge the
selected point(s) by the quantization specified in the Quantization menu at the top of the time-
line. By holding down the shift key and pressing an arrow key, you can move by the basic unit
of time (either a beat or a frame).

To drag a point (or points) to a new time without changing its value (or vice versa), click on one of the
points and then hold down the shift key before you start to drag. That will restrict the motion to
the initial direction of the drag: either horizontal or vertical.

You can change the time or the value of a point numerically using the data display/entry fields just
below the graph area. The time and value of the earliest of the selected points is displayed in
the fields at the bottom of the timeline. Type in a new time or new value followed by Enter.

Add some new points to the Rate control by option-clicking at various locations. Press Space to
hear the Sound with this changing parameter value. Add some new points to the Rate control
function and move some points around until you have something you think will make an inter-
esting Rate automation control. Then play the Timeline by tapping the space bar. Have a listen,
make some changes to the Rate control, and then listen again.

To CoMPILE OR NOT TO COMPILE

You may have noticed that some of the changes you make require the time-
line to recompile before you play it again, while others do not require it to
recompile and in fact can even occur while the timeline is still playing. Any
changes to the duration or position of Sounds require the timeline to
recompile the next time you play it. Changes to automated controllers, on
the other hand, can be made while the timeline is still playing. There is one
exception. The first time you change an automated controller from a con-
stant value to one that varies over time, the timeline will recompile prior to
playing with the new automation function. (This is due to an optimization
that can be made on constant parameters.)
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Slaving one control to another

Suppose you wanted one control to exactly mirror the changes in another control. You can
accomplish this by slaving one control to another. The master controller can be another control-
ler in the same Sound, a Track control for the track containing the Sound, or a Master control.

To slave one controller to another, first select the name of the parameter in the parameter list.
Then, in the state menu, select Slave to... and choose a master controller from the list of poten-
tial master controllers.

For example, let’s create a single master controller for controlling two different Control |
parameters of the reverb. First deselect all Sounds. Then go to the state menu, [ === """ |:
where it says Control, and select New Master. Give it the name ReverbMaster.
Scroll down in the parameter list to verify that ReverbMaster is now listed as one of the Master
controls. Select ReverbMaster and edit its graph to start at 0, increase to 1 at the midpoint, and
decrease until it reaches 0 again at the end.

4ReverbAmp

Track Controls
Level _Trk3
Angle_Trk3
Radius_Trk3
Hotes_Trk3

Master Contrals
BPM
ReverbMaster

Next, select the EuverbMono Sound. Then select ReverbAmp in the [automatea || take2
parameter list. In the State menu, choose Slave to and look through [Live contral
your choices for master controller. Notice that the choices are limited [t i Faceintut

Prormote to master Fanner

to the other parameters of EuverbMono, the track controls for the [Hew Master Distance

EuverbMono’s track, and master controls: BPM and ReverbMaster. D

Select ReverbMaster as the master control for ReverbAmp. Notice BFM

that ReverbAmp is marked with an up arrow in the parameter list to Ree b e

show that it is controlled from elsewhere. Its graph is a pale version of Angle_Trk3

) Radiuz_Trk3
ReverbMaster’s graph. Notes_Trk3

Next, select Decay, and slave it to the same master control, Reverb-
Master.

Slaved controllers are in the same state as the master control. In this example, ReverbMaster is
automated, so the two parameters slaved to it are also automated. Try making ReverbMaster
live. First, select it in the parameter list. Then, press down where it says Automated to get the
state menu, and select Live. Now play the timeline, and use ReverbMaster to control both the
decay time and the level of the reverberated signal.
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Controller transformations

The icon-labeled buttons across the bottom of the timeline are transformations that you can
apply to the selected controller automation graph. For example, switch ReverbMaster from live
back to Automated, create a new take, and draw a lopsided M shape like this one:

Master Controls 43

k%
“] Automated I takel _| @ @

Then try applying transformations to this graph one at a time by clicking on the transformation
button just below the Controls Editor.

Invert rotates the shape about a horizontal axis. Press the Invert button. When you get a cross
hair cursor, click on the axis of rotation. This is an example of inversion around 0.5:

Master Contrals 43
BPM

&
E Automated I takel _I E‘ E

Loop repeats the shape for as many full repetitions as will fit in the time span:

Master Contrals 43

Distance

4 Amp E .
[Hseveawo j[ ratemaster | Reverse flips the graph around a vertical axis. In other words, it is like

going through the graph backwards:

Master Controls 43
BPFM

Spray can adds random jitter to the graph between the break points. Press the spray can icon.
Draw a box with the cross hair cursor. The height of the box determines the size of the random
numbers. The width of the box determines how often a new random number is generated.

Master Controls 4

W
“] Automated I takel _I @ E
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Square off turns the graph from continuous to discrete. It jumps immediately to each new
value rather than sloping continuously from one value to the next.

0.0

k%
“] Automated I takel _I @ E

Scale multiplies every value of the graph by the same number. Click on the scale icon. Then
enter the scale factor. For positive scales graph keeps its same shape but will be shorter or taller
after the scaling. Negative scale values will invert the graph.

Master Contrals 43

0.0

k%
“] Automated I takel _I @ E

Offset adds the same number to each point in the graph. Click the Offset icon. Then enter the
offset. The graph looks exactly the same except that the whole thing is shifted up or down.

Master Contrals 43
EPM

i !
E Automated I takel _"—”—|

Threshold forces every point above a threshold to the value 1 and every point below a thresh-
old to the value 0. Click the threshold icon. Then draw a box. The vertical location of the box is
the threshold value. The height of the box is the hysteresis. In other words, it is the amount
above (or below) the threshold that the graph has to go before it is really considered to be above
(or below) the threshold. Think of a graph that has lots of small variations above and below the
threshold. If you don’t want the result to jump between 0 and 1 for each of those small varia-
tions, make the hysteresis a little larger than the small variations that you would like to ignore
by drawing the box a little taller than the small variations.

Master Controls ey
BPM

0.0

T = =
E Automated I takel _I @ E

Info displays for the automation controls

Just below the graph of the selected controller, there are two data entry/display fields. The first
displays the time of the selected point and the second displays its value. If more than one point
is selected, the time and value of the earliest point will be displayed.
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Parameter Controls

4

+

Track Contrals
Level _Trk4

([ Automated [ takeo | =

To change the time or value of the selected point, click in the appropriate field, type a new num-
ber, and press Enter. If more than one point is selected, you will set the position of the first
point, and the positions of all other selected points will shift relative to the new position of the
first point.

To quickly set all selected points to the same value, press Enter, type the value into the dialog
box, and press Enter again to set all selected points to the new value.

Audio Signals as Controls

There are two ways to use audio signals as parameter controls in a timeline. One is to extract
the frequency or amplitude envelope from a signal and use it as an automated controller. The
other is to convert a live audio input into a global control so you can control the parameter(s) in
real time. For example, you can create a timeline for a live performance, where the audio signal
from a musical instrument controls some of the parameters of the synthesized sounds or the
signal processing algorithms.

Extracting an amplitude or frequency envelope from an audio signal

To extract a controller from an audio signal, drag and drop the Sound into the controller editor.
For example, let’s control the Frequency parameter of Freg/Time Scaling Vocoder using the fre-
quency envelope of a different Sound.

First, select Freq/Time Scaling Vocoder, and then select Frequency in the parameter list. In the
Sound Browser, find the sample named karsten honey pie (in the Samples 3rd Party/Forced Media
directory). Play it first, so you are familiar with the melody.

Drag karsten honey pie from the Sound Browser and drop it into the editor for the Frequency
controller. A dialog opens, giving you a choice between selecting an Amplitude envelope, a
Frequency envelope or setting the value of BPM based on the duration of the dragged Sound.
For the purposes of this example, select Frequency and click OK. Wait for the duration of the
sample while the watch spins around and Kyma extracts the frequency envelope. (In this par-
ticular instance, you’ve dragged a sample into the timeline, so its duration is finite. However, if
you had dragged a Sound into the timeline, Kyma would ask how much of the Sound’s enve-
lope to extract. The default duration of a Sound is two years; it’s unlikely you’d want to wait
guite that long for the envelope extraction, no matter how entertaining that animated watch
cursor might be).

When Kyma has finished extracting the frequency envelope, it will display the melodic
D contour in the controller editor. Click the loop button to repeat that shape for the dura-
tion of Freg/Time Scaling \ocoder.
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You can see that the shape of the controller follows the melody of the sample. Now play the
timeline and listen for the pitch contour of Karsten’s voice imposed on the words of the ceph-
laphage.

Follow a similar procedure when you want to extract the amplitude envelope of a Sound. First
select the timeline parameter you would like to control. Then drag a Sound from the Sound
Browser or Prototypes and drop it into the controller editor. Select Amplitude as the envelope
you would like to extract. Sit back and look at the spinning wrist watch while Kyma plays the
Sound and extracts its amplitude envelope.

You can use the amplitude envelope to control any parameter of the Sound in the timeline; just
because it’s an amplitude envelope, it does not have to be used to control another amplitude
parameter. For example, you could use the amplitude envelope of a drum loop to control the
cutoff frequency of a filter in the timeline. In that particular instance, you might also want to
use the Scaling button to transform the extracted amplitude envelope into the right range for a
frequency parameter, but the shape of the envelope would be maintained. These kinds of cross-
modulations can be useful both in a musical context and in a sound design context.

Using the live audio signal as a live controller
You can also track a parameter of a live audio signal and con- [Tt Audic ]| Compressor10 || 1 || 00;

Set selected live controls to current values

vert it into a live controller in the timeline. This can be partic- [|ese Track controls (pans & fevels
- - - - Autamate all Farameter controls
ularly useful when you plan to perform live with a timeline, |ferae: P [pasor conteot
using different aspects of your live audio signal to control

various aspects of the processing and synthesis.

-

The key to converting some aspect of the audio signal into a live controller that shows up in the
Virtual Control Surface is to use one of the Sounds in the Global controllers category of the
Prototypes. Each of these prototypes converts some aspect of an audio signal into a live control-
ler that shows up on the Virtual Control Surface. For example, find the prototype named Amp
Follower to Global Controller, select it, and use Ctri+Space to play it. This prototype tracks the
amplitude envelope of an (unheard) drum loop sample and converts it into a controller called
Amp (which you should now see jumping wildly up and down in the Virtual Control Surface in
response to the drumloop’s amplitude changes).

In order to link this audio-derived-controller to a parameter in the timeline, you would drag the
Amp Follower to Global Controller into the timeline, and slave both Amp and the parameter
you want to control to a common master controller.

As an example, let’s try controlling the Rate parameter of the vocoder with the amplitude enve-
lope of a live signal from the microphone. Without closing the example timeline you’ve been
working on, create a new timeline (using Ctri+N). Copy Freqg/Time Scaling Vocoder from your
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old timeline, and paste it into Trk 1 of the new timeline. (Although it may be tempting, you can-
not drag a Sound from one timeline into another, because that would just move the Sound to a
new time and track within the same timeline). Next, drag Amp Follower to Global Controller
from the Prototypes into Trk2 of the new timeline, and stretch it out to the same length as Freq/
Time Scaling Vocoder.

Next we want to slave Rate and Amp to the same master controller. Select Freg/Time Scaling
\Vocoder so its parameters show up in the list of controls. Select Rate and select Promote to mas-
ter from the state menu (press the Automated button just below the list of parameters). This will
create a new master control with the default name of RateMaster, and it will slave Rate to Rate-
Master.

Now select Amp Follower to Global Controller, select the parameter named Amp, and use the
state menu to slave Amp to RateMaster.

Finally, select RateMaster and use the state menu to set it to Live control. Then play the time-
line. You should hear the vocoder slowing down and speeding up in response to amplitude
changes in the (unheard) drum loop.

Now let’s switch to the live input from the microphone so you can control the rate of the
vocoder with your voice amplitude. Option-drag (Ctrl-drag on the PC) an Input Channel 1 from
the Prototypes, and drop it onto Amp Follower to Global Controller in order to replace its
input with the audio input to channel 1 of the Capybara.

Now (assuming that you have a pre-amplified microphone feeding into channel 1 of your
Capybara) you can play the timeline again, and control the rate of the vocoder with the ampli-
tude of your voice. Try setting the value of Release up to its maximum, so you can hear the
effect die away after you stop making noise into the microphone.

Do a Save as... to save this timeline as an example, for future reference, on how to use an audio
signal as a controller (call it something like audio input controls rate). Then close it and return to
our regularly scheduled timeline.

Kyma timeline control as MIDI continuous controller output

The parameter controllers in the timeline are not MIDI continuous controllers; they are internal
to Kyma. However, there is a way to send them out of the Capybara as MIDI continuous con-
trollers. Suppose, for example, that you’d like to use one automated controller graph to control
both a Kyma Sound and a patch on an external synth—or that you prefer to use the timeline
editor to create control graphs for your MIDI devices. The key in both instances is to use a pro-
totype called M IDIOutputController. For example, create a new timeline, and drag MIDI-
OutputController from the MIDI Out category of the Prototypes into Trkl of the new timeline.
Set its duration to about 8 seconds.

Using the timeline to create MIDI continuous controllers

Select MI1DI1OutputController and look at its list of Parameter Controls. One of them, Amp,
represents the value that the M1DI1OutputController will send out on MIDI channel 1 as con-
tinuous controller 7. (That is the default output channel and the default controller number; you
can change these by editing the Sound).
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Select Amp, and change its state from Live to Automated. Use the controller editor to create a
shape that you will be able to recognize (try something along the lines of a triangular-shaped
slow increase followed by a slow decrease).

When you play the timeline, Kyma will send the time-varying value of Amp out as MIDI con-
troller 7.

Using the same controller for both Kyma and an external MIDI device
Make sure M IDI1OutputController is still selected and select its Amp parameter again. Use
the state menu to promote Amp to a master control called AmpMaster.

Drag another Kyma Sound (for example, VariableRateDisk from the Sources & Generators
category of the Prototypes) into the timeline. Set the duration of the VariableRateDisk to be
the same as that of the M ID I1OutputController—about 8 seconds. Select which of the Kyma
Sound parameters you’d like to control, for example, Rate. Using the state menu, slave Rate to
AmpMaster.

Now play the timeline. The rate change in the disk player will be mirrored by a change in the
MIDI output controller 7. Save this timeline as output midi controller, in case you ever need to
refer to it later as an example of how to do this.

BPM

The Beats per minute (BPM) controller is a master control that is automatically created when-
ever you create a new timeline. Initially, it is set to a moderate value of 120 beats per minute. If
you drag a Sound into a timeline and it has |BPM as one of its parameters, the local BPM
parameter is automatically slaved to the master BPM controller. Thus, in the default case, any
tempo-dependent Sounds that you drag into a timeline will be synchronized to a common
tempo. This being Kyma, it almost goes without saying that you can of course, unslave the local
BPM from the master controller or use the transformation buttons to make the local BPM a
function of the master controller.

Setting or changing the tempo

To instantaneously change the tempo on a specific bar or beat, use Option+Click (Ctrl+Click on the
PC) to add a point on that beat at the old value. Then add another point just after that at the
new tempo value.

To create an accelerando or ritardando, add a point at the original tempo on the beat where the
tempo change should begin and another point at the new tempo on the beat where the tempo
change should end.

Try adding a ritardando and accelerando to the BPM of your example timeline. Then play the

timeline, soloing the Trk2 (because Clicks is the only Sound that depends on the BPM). You’'ll
notice that the time cursor slows down and speeds up in sync with the tempo changes.
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If you switch the time units from Bars and Beats to Timecode, you may also notice that time has
become warped! Don’t be alarmed, though; this is just a way to bring “real time” into confor-
mity with musical time. Since the time cursor moves more slowly when the tempo slows down,
the marks for real seconds are closer together at those points. Or you could look at it as a repre-
sentation of what musicians have always known: time does not always proceed at the same
rate.

Setting the value of BPM based on the duration of a sample
Create a new Timeline using File new (Ctr1-N), and switch the units from Timecode to Bars and
Beats using the menu at the top of the timeline.

Select BPM in the list (on the lower left); the default BPM value for new timelines is 120.

Now locate rustDrum80p8 in the Sound Browser. (It’s in Samples 3rd Party/ Spectralnoise). Drag
rustDrum80p8 from the Sound Browser into the controller editor. When it asks you which
parameter you would like to extract, click BPM.

The dialog gives you a choice of two methods for inferring the value of BPM from the sample:
you can either assume that the sample is exactly one bar long, or, if it is not one bar long, you
can tell it the number of beats that you hear in the sample. For this example, select Set bar length
equal to the duration of this Sound. This will change the tempo such that the duration of the drum
loop Sound is the same as the duration of one measure. Select on of the points in the BPM graph
and read its value in the data display/entry field below. It should read 80. 82.

Change the grid mode from Free Grid to Magnet Grid, and drag rustDrum80p8 into Trk1 of the
Timeline. Notice that it fills exactly one bar at this tempo. Extend the duration of the sample to 8
bars by tabbing over to the duration field (or simply clicking in that field) and typing the value
8+ 0+ 0 (for a duration of 8 measures, zero beats and zero fractions of beats).

When you want to set a timeline’s BPM to the duration of a sample loop in the future, remem-
ber to drag the sample into the BPM controller editor first. Then drag the sample into the time-
line. If you do it in this order, the sample will last exactly one bar at the current BPM rate. In the
timeline, you can then lengthen the duration of the sample and it will loop to fill out the addi-
tional time.
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MINUTES, SECONDS, AND FRACTIONS OF SECONDS

BPM stands for beats per minute, so if you set the value of the BPM con-
troller to 60, you will get 60 beats per minute, or one beat per second. You
can use this fact to display time in units of minutes, seconds, and fractions
of a second. First create a new take for BPM and set its value to 60. Then,
set the time units to Bars and Beats. Change the grouping to 60 beats per
bar. Change the subdivisions to 1000 (for milliseconds) or 44100 (for sam-
ples if your sampling rate is set to 44,100 kHz). Whatever you choose as
the subdivision will determine the fractions of seconds.

Now you can interpret (Bar number - 1) as the current minute. (Beat - 1)
will be the current second, and the subdivision number will equal the num-
ber of milliseconds (or samples). Well, admittedly it is a bit twisted, but it
can come in handy sometimes!

Mixing
Returning to the mixer metaphor, you can think of each track as something like a strip in a mix-

ing console. It has an input, it has one or more outputs, and each track has a level control and
pan control(s) listed under Track Controls in the parameter list.

Creating a virtual mixing desk for a timeline

Select all of the Sounds in your example timeline. In the parameter list, scroll down until you
can see Track Controls. Each track has a level parameter named Level Trk followed by the
number of the track.

To set all of the track parameters at once to live control, click the Automation menu (at the top,
just below the transport controls), scroll down to Live control and over to the submenu where
you can select Track controls (pans & levels). That sets all of the selected Sounds’ track level and
pan controls to live. (Alternatively, you could have selected the parameters one at a time and
used the state menu below the parameter list to switch each one to live control. The Automation
menu provides a way to change the state of groups of parameters all at once).
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Play the timeline. The Virtual Control Surface is now a “mixing desk” for the timeline. It has
controls for the level of each track, and pan position (in the form of the Angle and Radius con-
trols).

O Virtual Control Surface>"sa=——-————————————— M| H
[ | — T R o | r—. N ol =
| B |Default =1 52 | Time Line =1 &

Angle_Trkl Angle_Trk2 Angle_Trk3

[ 0es2 [ 06208 [ 0474

Level_Trid Radius_Trid Level_Tric Radius_TrikZ Levei_Trk3 Radius_Trk3

[ [ [ [ B B

- - -
< < <

(You might have to unlock the VCS and use Arrange... Clean up this layout to get your virtual
mixing desk to look like the one above.)

Set each of the Radius controls to a value of 1 (by clicking in the numeric field, typing ina 1, and
pressing Enter). Now you can “mix’ the timeline by moving the Level controls.

(Each individual Sound also has a FadelnOut parameter for controlling its individual “enve-
lope”. The amplitude of an individual Sound at each point in time is determined by multiply-
ing its FadelnOut envelope value at that time by the overall track level at that time).

Play through the timeline a few times, adjusting the level controls until you like the balance of
the track levels. Then use the Automation menu to Set selected live controls to current values.

Submix levels
You can control how much a track contributes to a submix using the submix level track control.
This is a control on the level of track before it has been attenuated by the Track’s level control.

When you send a track’s output to a submix, a new Track control is automatically created as a
level control for that submix. The name of the controller is constructed out of the name of the
track, the word “To” and the name you’ve given to the submix.

For instance, since you routed Trkl to a submix called “vox” earlier, a track control called
Trkl_To_Vox was automatically created and added to Trk1’s list of Track Controls. If you then
brought “vox” in as an input to Trk3, the signal flow would be:

(Trkl * Level _Trk1) - Capybara output(s)
(Trkl * Trkl_To_Vox) - (Trk3 * Level_Trk3) - Capybara output(s)

Note that Trkl_To_Vox and Level Trk3 both end up affecting the level of the submix called
vox. However, Level Trkl has no affect on the level of vox.

Spatializing

As you’ve already noticed, two of the track controls, Angle and Radius, can be used to place
that track at a certain point in space.
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Specifying a position in polar coordinates

Imagine that you are sitting at the center of a circle, and that a sound source can be positioned
anywhere along that circle, inside the circle, or outside the circle. Let’s label a possible point
source of sound as its distance (or radius) and angle relative to Bozo the Clown’s® position at
the center of the circle.

0.5

0.25 0.75

: A :

-0.25 -0.75

-0.5

A sound source directly to Bozo’s left is at angle 0, a sound source directly in front of Bozo is at
angle 0.5, and a sound source to your right is at angle 1. (If you multiply these numbers by 180
degrees (or by pi), they will correspond to familiar angles). Positions behind you are the nega-
tive versions of the ones in front of you.

A sound source that is on the circle is at Radius 1, a sound source closer to you (on the inside of
the circle) has a Radius less than 1, and a sound source further from you (outside the circle) has
a Radius larger than 1 (but no larger than 2).

Panning the position of a track

For example, let’s pan the track containing the Sound Clicks in the example timeline. First
select Clicks. Then select its angle function, Angle_Trk2, in the parameter list. Create a new
angle function going from 0 to 2 in about 4 seconds. You may need to use the vertical zoom out
button at the bottom of the right scroll bar in order to draw the function all the way up to 2. Or
you could just type the number 2 into the value field and press Enter. Delete any points that
come after that. Then use the Loop button (one of the transformation buttons found below the

5. Chosen because his orientation is clearly indicated by unique nasal morphology and laterally symmetric folli-
cle placement in the cranial region.
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controller editor), in order to repeat the function In the end the function should look something
like this:

Now play the Timeline. Notice that the little sound source indicator on each track shows a yel-
low box at the position of the virtual sound source as it travels around the room. Try soloing
Trk2 in order to hear the panning in isolation.

Panning the position of a Sound relative to its track

Imagine now that Bozo is sitting on a spinning piano stool, rotating such that his nose is always
pointing in the direction of the virtual track position. From Bozo’s point of reference, then, the
sound would always be coming from a source directly in front of him. Each individual Sound
has a position relative to the position of its track. This position is specified in polar coordinates as
Panner (corresponding to Angle) and Distance (corresponding to Radius). So in the spinning
Bozo case, you could use Panner to cause Bozo to hear an individual Sound panning from left to
right even though he is unaware of the spatial movement of the entire track.

Another way to think of this to say that the Track position is as an initial or base position for the
sound source and the Sound position controls specify a change or deviation from that position.
(Of course, the base position can also be changing, in which case the Sound position controls
specify a change to a changing position!)

You could also think of the track position as the “carrier” and the Sound’s position as a modula-
tor or deviation from that carrier—a kind of “position modulation” analogous to frequency
modulation. And, just as in frequency modulation, the carrier does not have to be static; it can
be changing, typically at a slower rate than the modulator frequency, though even that is not a
requirement.

For example, you can imagine assigning each Track a fixed position in the stereo or surround
field by using Angle and Radius, and then specifying the movements of individual Sounds rela-
tive that track position using Panner and Distance.

Position panning versus routing to specific output channels

The advantage of using the panning controls instead of routing tracks to specific Capybara out-
put channels is that your timeline will work no matter how many output channels or what the
speaker configuration. For example, you could use a stereo setup in your home studio to pre-
pare a timeline for performance in a larger studio or performance space with 8 monitors. Con-
versely, you might create a performance piece using the 6 channel setup you have in your own
studio, and then perform it in lots of different venues with varying numbers of speakers. If you
use the panner controls rather than hard-routing the tracks to output channels, then your time-
line will automatically remix itself to whatever configuration you have to use at the time. If, for
example, you have some sounds spinning around the room in a quad setup, you can still play
the same timeline on a stereo setup. The sounds will still pan back and forth according to the
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same functions you were using before; it’s just that anything that was in the rear speakers will
now be mixed into the front two speakers.

How to set up your speaker configuration
To inform Kyma of your speaker configuration, go to the Edit menu and choose Preferences...

Then click the button called Speaker Placement...

Speaker Placement

In most cases, you can choose an already-defined setup
from the first menu: Placement preset. For example, if
you have your speakers set up in four corners but also
have a center channel in front and a channel running to refaive istance rom e nter o e ST 3 ach s
a special subwoofer speaker, you could choose Quad + s the gl of aach spesker (hard of 25,00 i= ity shes,
Ctr + Sub from the menu. When you choose one of the

Choose one of the common speaker placerments from the list below :

Placement preset: | Quad + Cir + Sub ||;|

Or, select the output channels that are connecied to speakers, the
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predefined setups, it will automatically fill in all the @1 [§_] [45 [Left Front |
specifics in the fields below. @2 s Teorceesy =
Alternatively, if your setup is not one of the common @3 |-43 tert Rear [
ones listed in the menu, you can specify the location of ®4 1 |-135 Right Rear (=]
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In the Speaker Placement set up, hard left is O degrees,
straight ahead is 90 degrees, hard right is 180 degrees,

8

iy
]

= - =
|8 nused E

and negative angles are the same as positive angles Subwoofer channel: [ 6 =
except that the speakers are behind you rather than in . - :
front of you. [ ok | [cancer]

In your timeline, use the Audio menu to set the number
of outputs that you intend for this particular timeline (that will help adjust the levels if you ever
have to mix down to fewer channels).

If you use the panner controls to spatialize your timeline, then you can play your timeline on
different speaker setups simply by editing the Speaker Placement information in the Prefer-
ences.

Recording a timeline to the hard disk

There are two different ways you might want to record a timeline to your hard disk. One is EI
that you might want to record the audio that would have gone to each output channel into

a separate audio file. In other words, if you have a surround timeline with lots of panning func-
tions in it, you might want to record the audio for output channel 1 into one mono file, the
audio for channel 2 in another mono file, etc. The end result is that you would have six separate
mono audio tracks that you could then import into your favorite DAW or send to a client. The
second mode of recording to disk is to “cache” individual Sounds in the timeline by recording
them on disk. This can be useful if you are building a complex mix and run out of real-time DSP
power. By caching some of the Sounds to disk, you free up your DSPs for more real-time syn-
thesis and processing without losing the process by which you created the original Sounds.
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Recording each audio output channel into its own mono disk file
To record what would have gone to each audio output channel of your Capybara, click on the
Action menu and select Record to disk...

Piease seiect the channels to record and the recording format:

Record Dutput Channels Format Resolution

@] @2 @3 @4 @ RAIFF 18 bit
- - = = iS00 &1 hit
Bs e 17 [18 Gson =R
= e T 124 hit
(I Microsofi liave =
Z IRCAM/™MTU

Select the desired file format and bit-depth. (The sample rate of the recording will be whatever
sample rate you have currently selected in the DSP Status window). Use the check boxes to
select which of the output channels you would like to record. You do not have to record all of
them at once; you can make several passes over the timeline, recording a different set of output
channels each time through.

You could even record more channels than you actually have! For example, suppose you have a
basic Capybara with four audio outputs, and you’re working on a job where they’d like you to
supply the result as 6 channels of surround. First, you could closely approximate the placement
and panning using a timeline and your quad setup. Once you were happy with the result, you
could use the Edit Preferences Speaker Placement dialog to con Kyma into thinking that you
actually have a 5.1 Surround setup by selecting that from the list of predefined configurations.
And finally, you would select Record to disk... from the Action menu in order to record 6 audio
tracks to the hard disk.

Caching individual Sounds to disk to save DSP resources

Whenever possible, it is best to leave your Sounds fluid and as adjustable. In other words, the
longer you can postpone recording them to disk, the longer they remain changeable and per-
formable. At some point, though, if you have a Sound pretty much the way you want it, and the
complexity of your timeline is beginning to tax your available DSP resources, caching a Sound
to the disk is probably the best way of freeing up DSP resources without losing any of the his-
tory of how your Sound was created.

To cache an individual Sound on disk, find the DiskCache prototype (use Ctri+B or look in the
Prototypes under the Disk category), drag it from the Prototypes into the timeline, and drop it
onto the Sound that you’d like to record. The next time you play the timeline, that Sound will
be recorded to disk as it is playing. Immediately after recording, edit the DiskCache so you can
change the check box from Record to Play. From then on, a recording of the Sound will be
played from the disk rather than generated live. However, it is reassuring to know that, if you
do want to make further changes to the Sound, all you need do is to click on the Sound and
press the minus (-) key to remove the DiskCache and return to generating the Sound in real-
time.

Try this out on your example timeline. Drag a DiskCache from the Prototypes and drop it onto
the Freqg/Time Scaling Vocoder. Play the timeline. A dialog pops up asking you for the file for-
mat, number of channels, and the bit resolution of the recording. Select an AIFF Mono 16-bit file
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and click OK. Next, Kyma will ask where you’d like to save the file and what you’d like to name
the file. Name it vocoder cache, and save it where you can easily find it and throw it away after
you finish with this example. Click Save or press Enter. The timeline will proceed to play, and
the vocoder will be recorded to the disk as you listen to it.

Once the timeline has finished, you should immediately edit the DiskCache to play the record-
ing from disk. To edit, double-click on the DiskCache(Freq/Time Scaling Vocoder) Sound,
opening the Sound editor window. Uncheck the Record box so the DiskCache will read from
the file specified in the FileName field. Then click on the disk icon to the right of the FileName
field, and use the file dialog to locate the file named vocoder cache.

Close the Sound editor by clicking the close box on the window. Kyma will ask you whether
you want to keep the changes you just made, so click Yes or press Enter.

Play the timeline again. This time, the vocoder is being read from a disk file rather than gener-
ated in real time, so you should probably notice a difference in the amount of DSP usage shown
in the DSP Status window. Make a mental note of how much DSP processing is being used.

Then, select the DiskCache Sound in the timeline and press the minus (-) key to remove the
cache. Play the timeline again, and take note of how much more DSP power is being used.

If you every find yourself running out of processing time, try selecting some of the Sounds that
are not being performed in real time and cache them on disk. This will free up more DSP power
for use on the Sounds you are performing live or the Sounds whose parameter automation you
are still adjusting.

Controlling the flow of time in a live performance

In a live performance (whether that performance is on stage or in your own studio as you sync
to picture), you need to be able to control the flow of time rather than being slaved to a click
track.

To change or stop the flow of time in a timeline, you can use the prototypes called TimeStopper,
WaitUntil, or TimeController. These Sounds affect one kind of time—cursor time—without
affecting another kind of time—the sample rate clock. What this means is that you can slow
down or stop the time cursor without slowing down or stopping the sound itself. By placing
one of these Sounds into a timeline, you can slow or stop time at the moment that the time cur-
sor reaches that Sound.

What stops and what keeps on going?

The time cursor, automated controllers, MIDI file readers, and MIDI Scripts are all affected.
Synthesis, sample playback, live processing, and expressions in parameter fields that depend
on time (e.g. ramp:) all continue to do their things even when cursor time has come to a halt.

Think of the timeline, not as a DAW or sequencer, but as a program-scheduler for your Capyb-
ara computer. Whatever programs are running when the time cursor runs across a WaitUntil
will continue to run forever (or until you break through the WaitUntil by satisfying its Resume
condition).
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Example of how to use WaitUntil to pause the time cursor

The best way to see how to do this in your own timelines is to take a look at a relatively simple
example first. Use the Sound Browser to locate the timeline named WaitUntilExample in the Time-
lines directory. (Make a note of where this is, because you may want to come back here later to
play the other timelines in this directory). Double-click on waituntilExample to open the timeline.

IIoop [fadeInProc Iproc+|00p |be linProcout IIJeIILoop [fadeutEell

T T T T T T T T T
00 100 :00.00 |EIEI {00 :0Z.00 |00:00:04.00 |EIEI {00 :06.00 |EIEI {00 :08.00 |EIEI :00:10.00 |EIEI 00:1Z.00 |EIEI ‘00:14.00 |EIEI ‘00:16.00 |EIEI

&
|}w b lILoopetc
T

The WaitUntil Sounds are the ones in Trk1 with the little upheld index finger icon.

‘ou whizperLoop

|§ liveProsessing

Double-click on the first WaitUntil and examine its parameters. The Resume field contains the
signal that will restart time. In the case of this first WaitUntil, time will resume when it gets a
MIDI 'KeyDown message. The same holds true for the second WaitUntil. Finally, take a look at
the Resume condition for the third and last WaitUntil. This one will resume when a middle C
is detected in the audio input signal.

Play this timeline by pressing the space bar. When the time cursor reaches the first WaitUntil, it
stops. The “nothing ever disappears” sample will loop forever or until you send it a 'KeyDown
(hope you have a MIDI keyboard handy or you could be listening to “nothing ever disappears”
for a very long time...)

Once you hit a key and break through the first WaitUntil, you will be able to do some live pro-
cessing of the audio input layered with the loop. If you have a microphone hooked up (or some
other line level signal feeding into your Capybara), you can hear yourself processed through
that effect. Both the live processing and the looping sample will go on forever unless you press
a key on the MIDI keyboard again.

Now the live processing fades out and a bell loop starts up in the transition before the next and
final WaituUntil. Now you are going to have to sing a middle C to finally get to the end of the
timeline. The bell just happens to be tolling a C, so that should help. Sing a nice clear “000”” on
the same pitch as the bell, and time should start up once again so you can get to the end of this
tutorial.

To jump over a WaitUntil, click in the time ruler. That causes the time cursor to jump to the
time you just clicked, so you can always jump around a WaitUntil if you don’t feel in good
voice today.

Kyma 5.00 Page 64 July 17,2000



K ¥y ma . 5 W A LK THROWUGH

A typical session with the timeline

MIDI AND SPATIALIZING IN THE TIMELINE

Because the timeline takes over much of the functionality of the MIDI-
Voice module and the multiple-output modules in the Prototypes Spatializ-
ing category, it is not necessary to use these modules in the timeline. In
fact, if you do drag one of these modules into a timeline it creates an
ambiguity—should it use the spatializing features of the timeline or of the
module? Should it use the polyphony specified in the timeline or in the
MIDIVoice? For that reason, you should take the input or inputs of these
modules and place them into individual tracks of the timeline, rather than
dragging the top level MIDI1Voice or multiple output Sound into the time-
line.

To end the section on the timeline, let’s imagine what a typical timeline work session might be
like. Try creating your own timeline as you read along (referring to earlier sections if you’ve for-
gotten any of the procedures). Have fun!

Open a new timeline using File new (Ctri+N). First, search the Kyma Sound Library for some
kind of background or pad texture. One good place to look is in Synthesis-Background & Pads.
Test out a few until you find one you like. Then drag it into your new timeline, and change its
duration to 60 seconds or so. Play the timeline. Use the Virtual Control Surface to adjust the
parameters the way you like them. To access the presets of this Sound, click in the layout menu
in the upper right of the Virtual Control Surface and go down a level from the Timeline layout
to the original layout for this Sound. When you are happy with the settings, make sure the
Sounds is still selected and use the Automation menu to Set selected live controls to current val-
ues.

Next, add some rhythmic material. Some promising places to mine for rhythmic material
would be the Looping category of the Prototypes, the Drum machines category of the Prototypes,
or the Sequencers category of the Prototypes. In the Kyma Sound Library, look in Sam-
pling:Rhythmic loops, or in the Sequencers folder. When you find something you like, drag it into
your timeline and use the Virtual Control Surface to adjust the parameters (and the Automation
menu to Set selected live controls to current values). At this point, you might also want to edit the
master control called BPM.

Now, to add some sampled material (or a voice over), use the Sound Browser to locate a folder
of your own samples (or select something out of Kyma.5 Samples or Samples 3rd Party). Double-
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click on it to open the Samples Editor. Select a small clip in the sample. Listen to it by pressing
the play button just above the large sample window.
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Copy it using ctri+C. Click in the timeline on Trk3 and paste the clip at that point. Repeat this
procedure until you have all of your voice over or sample material.

Now for some fun! Try dropping different effects from the Prototypes or the Sound Browser
onto the Sounds already in your timeline. If you don’t like the result, use Edit Undo, or press the
minus (-) key to remove the effect.

If you find yourself running out of DSP power, drag a DiskCache onto one of your Sounds and
record it onto your hard disk.

Route some of the tracks to a submix, and bring the submix in on another track. Then drag one
of the reverbs onto that track.

Edit the Track parameters called Angle and Radius so you can place each track in space. Try
using the Spray Can transformation to pan one of the tracks randomly around the room.
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THE SOUND EDITOR

To open an editor on any Sound, whether it is in a timeline, in the Sound Browser, in the Proto-
types, or in a Sound file window, double-click on the Sound. For example, use the Sound Browser
to locate Effects-Doppler shift in the Overview folder of the Kyma Sound Library. Double-click on
it to open an editor.

Signal Flow (the upper half of the Sound editor)

At this point, you are either entering a whole new world (if you are new to Kyma) or returning
to a familiar sight (if you have been using Kyma 4.5).

The upper half of the Sound editor shows you the signal flow of the modules that make up the
Sound. This is also where you can modify the Sound by adding or deleting modules from the
signal flow diagram.

Hiding and displaying branches of the signal flow

If the left-most module has a small tab on its left edge, that is an indication that there is more to
the signal flow diagram, and that it is currently hidden. To open the next level, click on the
small tab.

[Effects-Doppler shift] [Effects-Doppler shift]

To completely open the entire signal flow diagram, hold down the Ctrl or Cmd key and click
the little tab.

If the entire signal flow is open the next level, click on the small in-arrow icon attached to the
left edge of the icon. Continue opening levels until you see icons that do not have the little
arrow icons attached to their left sides. (To completely open the entire diagram, hold down the
Ctrl key at the same time you click on the arrow icon).

Color-coding of modules
Signal sources are color coded as red-tinted icons. Signal modifiers are blue. Sounds that are
used as control signals, rather than audio signals, show up as yellow icons.
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The Replaceable input
Notice that one of the Sounds, the Mixer just to the left of doppler shifter, has a cyan halo
around it. That’s because this is the replaceable input for the entire Sound.

RIGHT ; phs delay, intenzity diff

If you were to drag Effects-Doppler shift and drop it onto a Sound in the timeline, the replaceable
input is the module within it that will be replaced by the Sound in the timeline.

In the Sound Browser, you can tell that Effects-Doppler shift has a replaceable input, because it
has a cyan arrow next to its name. As you already know, the cyan arrow indicates that you can
replace its replaceable input with the global input that you have specified into the field at the
top of the Sound Browser.

To choose one of the modules in a signal flow as the replaceable input, select it, go up to the
Action menu and choose Set replaceable input. The selected Sound will acquire a cyan halo and
all the behavior of a replaceable input.

What if you had selected one of the GenericSources as the replaceable input? Then, if you were
to drop the Effects-Doppler shift onto a Sound in the timeline, you would hear a mix of the time-
line Sound plus one of the car samples. Similarly with the Sound Browser, the global input
would replace just one of the car samples, so you would hear a mix of the global input plus the
other car sample going through the doppler effect.

But Wait; There's More!

Actually, there is lot more to working with the signal flow editor, but that is the end of our walk-
through tour of the new features in Kyma.5. Don’t worry, though, because the nearly 600 page
manual called The Kyma Language for Sound Design awaits to satisfy your every curiosity about
the signal flow editor and other exciting topics such as:

Tools

The Wave Editor

The Spectrum Editor

Real time Arithmetic and Time Functions in Parameter Fields
Encapsulating a Complex Sound

However, this would be a good point to take a break from reading manuals, so you can explore
the Sound browser, timeline and Virtual Control Surfaces for a while. Then you will be ready to
dig into the main manual, starting with the Introduction and the Tutorials!
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THREE MODES OF USING KYMA

As a creative individual, you have three modes (at least): an exploratory phase where you are
listening and reading and taking in information, a solitary phase where you cut yourself off
from the outside world and immerse yourself in creation, and a “linking” phase where you
pause to make a progress report that you can interactively present to your audience in the out-
side world.

Kyma can assist you in different ways during each of these phases. In “pre-production” mode,
Kyma can be your sound design playground where you can explore the existing Sound library
and experiment with new combinations, building up a larger and larger treasure trove of new
Sounds of your own design. During “production:” mode, in the heat of creation, you will be
drawing upon your private store of Sounds, combining them and applying them to the project
at hand. And finally, in your “public” mode you can exploit Kyma’s real-time capabilities for
performing your work on stage, for giving live interactive demonstrations and talks, or creating
sound installations.

The more time you invest in Kyma, the more it will repay your efforts by leveraging your cre-
ative intelligence.
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APPENDIX

Default Parameter Ranges
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Kyma 5.00

[ -0.5 thru: 1.5].
[ -12 thru: 12].

[ -12 thru: 12].
[0 thru: 2000].
[-1 thru: 1].

[ -1 thru: 1].

[-1 thru: 1].

[ 0.75 thru: 1.25].
[0 thru: 1].

[0 thru: 1000].

[ 1000 thru: 8000].

[ 8000 thru: Signal Processor sanpleRate * 0.5].

[lc = "cutoff'] ifTrue: [0 thru: 10000].
[0 thru: 10].
[-128 thru: 128].
[-1 thru: 1].
[-24 thru: 24]
[-1 thru: 1].

[0 thru: 127].

[0 thru: 127].

[0 thru: 127].
[-1 thru: 1].
[-0.5 thru: 1.5].
[-2 thru: 2].

[0 thru: 2].

[0 thru: 100].

[0 thru: 10].

[-2 thru: 2].

[0 thru: 12].

[0 thru: 0.5].
[0.0001 thru: 5].
[-60 thru: 0].

[0 thru: 24].
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